OpenRTK Documentation

Aceinna Engineering

Apr 07, 2022



Table of contents

I About OpenRTK

1 Overview

II Tutorial

2 Quick Start

3 How to Use OpenRTK330 EVK?
4 Firmware Online Upgrade

5 OpenARC GNSS Correction Service

III RTK/IMU Modules

6 The OpenRTK330LI Module

IV Evaluation Kits

7 The OpenRTK330LI EVK

V  Communication protocol

8 ACEINNA protocol data format definition
9 USER UART Data Packet

10 DEBUG UART Data Packet

11 Port command

12 CAN Interface Data Protocol

13 NMEA

17
43

50

54

55

65

66

79
80
81
85
89
91

95




VI RTKIib tools 97
14 Overview 98

15 Instructions 101




OpenRTK Documentation

OpenRTK is an integrated GNSS (Global Navigation Satellite System) high precision chip and precisely calibrated
Inertial Measurement Unit open-source platform for the development of navigation and localization algorithms. Users
are able to quickly develop and deploy custom navigation/localization algorithms and custom sensor integrations on
top of the OpenRTK platform. OpenRTK also has pre-built drivers in Python as well as a developer website - Aceinna
Navigation Studio (ANS). These tools make logging and plotting data, including custom data structures and packets
very simple.

Social: Twitter | Medium
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About OpenRTK




CHAPTER 1

Overview

OpenRTK is an integrated GNSS (Global Navigation Satellite System) high precision chip and precisely calibrated
Inertial Measurement Unit open-source platform for the development of navigation and localization algorithms. A
free Visual Studio Code (VSCode) extension is installed which contains all the software and tools necessary to create
and deploy custom embedded sensor apps using OpenRTK. Visual Studio Code is the recommended IDE and the
extension configures VS Code to include easy access to compilation, code download, JTAG debug, IMU and GNSS
data logging as well as OpenRTK platform updates and news. A developer website called Aceinna Navigation Studio
(ANS) includes additional support tools including a GUI for controlling, plotting and managing data files logged by
your Custom RTK/IMU module. About OpenIMU, you can refer to Aceinna OpenIMU Developer Manual.

OpenRTK™ Aceinna
Hardware Navigation Studio™

Major Benefits:

Cutting Edge Hdw &

Algorithms
T Simulation .
RTK Module Data Logging Minimize Field Test
Charting
Mapping Save SM’s in NRE
App Marketplace
Community Learn, Grow & Follow
Embedded Software GNSS RTK/cloud RTK a trusted partner

The OpenRTK and ANS platform and tool-chain are supported on all three Major OS cross-development platform:
* Windows 7 or 10
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* MACOS 10

e Ubuntu 14.0 or later

Note: Contributions to the public repositories related to this project are welcomed. Please submit a pull request.

The following pages cover:
* What is OpenRTK
e What is the Acienna Navigation Studio

* Who is using OpenRTK and the Acienna Navigation Studio

1.1 What is OpenRTK?

OpenRTK is an open source hardware and software platform for development of high-performance navigation and
localization applications on top of multi-constellation, multi-frequency Global Navigation Satellite System (GNSS)
chips, a family of low-drift pre-calibrated Inertial Measurement Units (IMU) and cloud based server supports.

¢ Hardware

— OpenRTK hardware features of a multi-frequency, multi-constellation GNSS chipset from STMicroelec-
tronics (aka ST), a triple-redudant 6-axis IMU sensor module from Aceinna, and an embedded STM32
ARM Cortex-M4 MCU with floating-point computation support for complex positioning engine

— Spare I/O and ports for external sensors such as Odometer, camera for enhanced sensor fusion navigation

— There comes two form-factors as follows:

Model Description

OpenRTK330LI | Inertial Navigation System Module — Industrial Grade

RTK330LA Inertial Navigation System Module — Automotive Grade (Contact Aceinna)
* Software

OpenRTK embedded software (i.e. the module firmware) is developped on top of the standard STM32
Cortex MCU library

Utilizes the FreeRTOS as the real time operating system for MCU

Provides a cost-free embedded environment and toolchain using VS Code and the associated Aceinna
extension (based on PlatformIO)

Features with open-sourced firmware in the drivers and user interfaces, user can use or modify the provided
firmware code to utilize or customize:

+ raw IMU data generation in sensor data extraction, pre-filtering and output data rate/format/interface
and so on

# UART input/output baudrate/mode/messages

*

CAN input/output mode/messages

*

Ethernet driver and input/output mode/messages

SPI driver

*

Bluetooth driver

*
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https://code.visualstudio.com/
https://platformio.org/

OpenRTK Documentation

— Features with proprietary positioning engine library (NOT open-sourced):
% GNSS Real Time Kinematic (RTK) positioning engine
* GNSS/IMU integrated Inertial Navigation System (INS) positioning engine
* Cloud Service

— OpenRTK cloud service provides Networked Transport of RTCM via Internet Protocol (NTRIP) server
and caster service for GNSS correction data

— Provides online developer site for user interface
* Web GUI
+ Data and algorithm simulation
* Database for storage

# Live support forum

1.2 What is Aceinna Navigation Studio?

@ developers.aceinna.com Q ¥ £

28 LOGIN JOIN

NCE

Navigation Studio™

Simulate, Deploy, and Analyze
Navigation Systems

GET STARTED

© Simulate <> Code & Deploy @ Analyze

* The Aceinna Navigation Studio (https://developers.aceinna.com) is a navigation system developer’s website and
web-platform.

* It consists of a graphical user interfSace to control and configure OpenRTK units.

» Using a JSON configuration file (“openrtk.json”), the graphical user interface can be customized for user specific
messaging and settings without any additional coding. This aligns the embedded code with both the Python
device server and the GUI pages available on ANS (https://developers.aceinna.com).

* Online tools include graphing, mapping, logging, simulation, GNSS RTK, and GNSS cloud RTK.

* User Forum is available at (https://forum.aceinna.com).

1.2. What is Aceinna Navigation Studio? 5
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Python & the Acienna Navigation Studio

The Acienna Navigation Studio (ANS) requires Python to operate. If the user has not installed Python, it can be
installed from https://www.python.org/downloads/. Download and install the latest version.

An open-source Python driver for openrtk is available and required. The Python driver can be used directly from the
terminal to load, log, and test your application. The driver leverages the PySerial library to connect to an OpenRTK
of a serial connection. The python script supports configuring units, firmware updates (JTAG is faster for debugging),
and local data logging.

In addition, the open-source Python driver can acts as a server connecting the OpenRTK hardware with our ANS
developer platform for a GUI experience, cloud data storage and retrieval, as well as stored file charting/plotting tools.

The Aceinna VS Code extension ensures a python environment automatically. The OpenRTK python code can be
installed independently by cloning the repository https://github.com/Aceinna/python-openimu or using pip as shown
below.

pip install openimu

1.3 Who is using it?

OpenRTK is to be used for commercial applications in agriculture, transportation, unmanned vehicles, machine con-
trol, marine navigation, and other industries where efficiencies can be gained from the application of precise, continu-
ally available position and time information.

1.3.1 Applications

==

ACE

OpenRTK330LI
P/N 8350-3021-01

Unmanned Vehicles

Initially, unmanned vehicles were used primarily by the defense industry. However, as the unmanned vehicle market
has grown and diversified, the commercial use of unmanned vehicles has also grown and diversified. Some of the

1.3. Who is using it? 6
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current civilian uses for unmanned vehicles are: search and rescue, crop monitoring, wildlife conservation, aerial pho-
tography, environmental research, infrastructure inspection, bathymetry, landmine detection and disposal, HAZMAT
inspection and disaster management. As the civilian unmanned vehicle market expands, so will the civilian use of
unmanned vehicles.

Machine Control

GNSS technology is being integrated into equipment such as bulldozers, excavators, graders, pavers and farm ma-
chinery to enhance productivity in the realtime operation of this equipment, and to provide situational awareness
information to the equipment operator. The adoption of GNSS-based machine control is similar in its impact to the
earlier adoption of hydraulics technology in machinery, which has had a profound effect on productivity and reliability.

Precise Agriculture

In precision agriculture, GNSS-based applications are used to support farm planning, field mapping, soil sampling,
tractor guidance, and crop assessment. More precise application of fertilizers, pesticides and herbicides reduces cost
and environmental impact. GNSS applications can automatically guide farm implements along the contours of the
earth in a manner that controls erosion and maximizes the effectiveness of irrigation systems. Farm machinery can be
operated at higher speeds, day and night, with increased accuracy. This increased accuracy saves time and fuel, and
maximizes the efficiency of the operation. Operator safety is also increased by greatly reducing fatigue.

Note: This product has been developed exclusively for commercial applications. It has not been tested for, and makes
no representation or warranty as to conformance with, any military specifications or its suitability for any military
application or end-use. Additionally, any use of this product for nuclear, chemical or biological weapons, or weapons
research, or for any use in missiles, rockets, and/or UAV’s of 300km or greater range, or any other activity prohibited
by the Export Administration Regulations, is expressly prohibited without the written consent and without obtaining
appropriate US export license(s) when required by US law. Diversion contrary to U.S. law is prohibited. Specifications
are subject to change without notice.

1.3. Who is using it? 7
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CHAPTER 2

Quick Start

Contents

* OpenRTK330LI EVK Introduction
* Quick Setup and Usage
— Prerequisites

— Usage Steps

e Note

Note: if the figures are blur, click on the figure to see the clearer version

2.1 OpenRTK330LI EVK Introduction

The OpenRTK330LI Evalution Kit (EVK) is designed to evaluate the OpenRTK330LI module with the online Aceinna
Navigation Studio (ANS) and related software stack. A full set of OpenRTK330 EVK is shown below after you unpack
the product box.

where

e 1: ST-Link debugger

e 2: Multi-Constellation and Multi-frequency GNSS antenna, supports
GPS L1/L2/L5
GLONASS L1/L2
GALILEO E1/ES/E6

- BEIDOU B1/B2

* 3: Micro-USB cable
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* 4: OpenRTK330 Evaluation Board (EVB) with metal flat mounting board
* 5: 12-V DC adapter with 5.5 x 2.1 mm power jack
The picture below shows the detailed overview of OpenRTK330 EVB

where some of the parts are listed here
* 1: OpenRTK330 GNSS/IMU integrated module
e 2: GNSS antenna SMA interface
* 3: Espressif ESP32 bluetooth module
* 4: SWD/JTAG connector, 20-pin
o7

: Boot mode swtich

— Position A: booting from bootloader

2.1. OpenRTK330LI EVK Introduction
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— Position B: normal working mode

8: RJ45 jack for Ethernet connection
* 9: Micro-USB port
10: 9-pin CAN interface

— Pin-7: CAN_H signal

— Pin-2: CAN_L signal
¢ 12: EVB working status LEDs, yellow, red, and green LED from left to right

2.2 Quick Setup and Usage

2.2.1 Prerequisites

Hardware
* OpenRTK330LI EVK
¢ Ethernet cable (must have, not included in the EVK)
 Ethernet router/network switch (optional, not included in the EVK)
Software
* The online Aceinna Navigation Studio (ANS) deverloper website, manily for
— OpenRTK devices management and technical forum and support
— Web-based Graphical User Interface (GUI)

— App center for online firmware upgrade

* The OpenRTK Python driver: Python based program runs on a PC, click here to download the latest version of

executables

— Send/Receive data from ANS to enable Web GUI and online firmware upgrade for OpenRTK330LI device

— Log and parse OpenRTK330LI output data, positioning solution and other debug information to binary

and text files

2.2.2 Usage Steps

1. Power and data link: connect the EVB with a PC using a Micro-USB cable, and the YELLOW LED (#12 on
the EVB figure above) flashes. The EVB is powered on, and four serial com ports are established on the PC.

2. Antenna: connect a GNSS multi-frequency antenna to the SMA interface (#2 on the EVB figure), the GREEN
LED (#12 on the EVB figure above) flashes if the incoming GNSS signal is valid

3. Network: Use an Ethernet calbe to connect the EVB with a network router or switch, and then connect a PC to
the same router/switch using an Ethernet cable. The OpenRTK330LI EVB gets internet access and assigned an

IP address in the local network via DHCP.

4. GNSS RTK and INS Configuration: open a browser (Google Chrome is recommended), visit http://openrtk,

* You will firstly see the following device running status page

2.2. Quick Setup and Usage
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@ OpenRTK x  + v
€« C @ Fz=2 | openrtk/runStatus.shtml T 0
Aceinna Open
MENU Running Status
Running Status GENERAL: GPS Time INS
e T Statien Mode: GPS Week: 2136 INS Status: INS_INACTIVE
NTRIP-CLIENT Time of Week(s): 368602.00 INS Position Type: INS_RTKFIXED
INS uration Station Status
e NTRIP-CLIENT & RTCM AVAILABLE Position Velocity
Mode: RTK_FIXED Vel Mode: DOPPLER
Ui T Latitude(°) 31.49444552 North(m/s) -0.002
Ethemnet Configuration Longitude(®) 12036282419 East(m/s): 0.004
Device Info Height(m): 119.227 Up(m/s): 0.005
Number of 8Vs: 23
HDOP: 06 Attitude
AGE(s): 20 Roll(°): 0.000
Pitch(°) 0.000
Heading(®): 0.000
Satellites

BDS(12):1,4,6,7,9,10,16,21,22,26 29,36
GPS(7)10,22,25 26,29 31,32
GLO(5)34.5.14,15
GAL(5):1,4,19.2131

* On the left side menu bar, click “Work Configuration” tab to choose the following working mode of
the device and configure it accordingly:

— Rover: works as a nomarl GNSS positioning unit that is also referring to “NTRIP client” re-
ceiving GNSS data correction

— Base: works as a GNSS reference station with known position and sending GNSS data to
“NTRIP server” to be used as GNSS data correction

Please refer to the “How-to-use” chapter for the detailed configurations.

@ OpenRTK x  +

& C ® +~2=2 | openrtk/openareclientcfg.cgi t O
Aceinna Open
MENU Work Config

Running Status
ROVER OpenARC CLIENT
Work Configuration Yjvs[g:(::nrgxg{)?eam“
INS Configuration L\I(EF:LT_H%I&LENT (w7 IP: openarc.aceinna.com
— PORT. a1t
Can Configuration
MOUNT POINT:  [rtk
User Configuration USER NAME! ftest
Ethernet Configuration \B,‘,ﬁfas base station EASSVORD 123455
with NTRIP SERVER
Device Info mode. Position can be SAVE ENABLE
reference pos set by
user or SPP/RTK
average result

¢ On the left side menu bar, click “User Configuration™ tab to select the user output data and rate
among the options provided, including NMEAQ183 messages and Aceinna format binaries

2.2. Quick Setup and Usage
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@ OpenRTK X+

%
@

& C @ F=%£ | openrtk/userCic

>
a

@

o
=]

=]

)
o

@

=]

~

MENU USER UART SETTING

Running Status ACCEINNA PACKET (BYTE)
RAWIMU 100Hz ¥
BESTGNSS: [1Hz v
INSPVAX. 100Hz *
ODOSPEED: [10Hz ¥
SATELLITES: [1Hz v

Work Configuration

=
&
=
o
S

I /

Can Configuration

User Configuration

NMEA
Ethernet Configuration
GNINS: OFF v
Device Info GPGCGA: Hz v
GPRMC: 1Hz v
PASHR: OFF v
GSA: OFF v
ZDA. OFF v
VTG OFF v

* On the left side menu bar, click “Device Info” tab to have the detailed device information displayed,
including firmware version, product number and serial number etc..

@ OpenRTK x o+

&« C ® F== | openrtk/devicelnfo.shtml % O

i

Aceinna Open
MENU Device Info
Running Status Product Name:  OpenRTK330L
Work Configuration My OpeniMU330BI
. PN: 5020-3021-01
XS G elieT Firmware Version: 23.00.01
Serial Number: 1975000005
App Version: RTK_INS App v23.00.01

User Configuration

Ethernet Configuration

Device Info

5. Live Web GUI: download the latest Python driver executable (v2.2.4 and later), and run it in a command line,
for example:

cd c:\pythondriver-win
.\ans-devices.exe

¢ Check the console output, the Python driver connects the device and the online ANS website, if successfully,
the following connection information is displayed

2.2. Quick Setup and Usage 14
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E¥ Administrater: cmd x + O X

Microsoft Windows [Version 10.8.18362.53]
(c) 2019 Microsoft Corporation. All rights reserved.

C:\Users\Administrator>cd c:\pythondriver-win

c:\pythondriver-win>ans-devices.exe
Python driver versio 2.2.3

Prepare to find device

Websocket server is started on port 8866

OpenRTK log GNSS UART COM12
OpenRTK log DEBUG UART COM13
{'openrtk configuration': {'Product Name': 'OpenRTK338L 'Product PN': '5020-3821-81 23.66.82', 'Product SN': 1975000080
: 'RTK_INS App v23.00.82', 'pri_lever_arm_bx': @, 'pri_lever_arm_by': @, 'pri_lever_arm_bz': ®, 'vrp_lever_a
8, 'vrp_lever_arm_by': 8, 'vrp_lever_arm_bz': 8, 'user_lever_arm_bx': ®, 'user_lever_arm_by': 8, 'user_lever_arm
, 'rotation_rbvx': 8, 'rotation_rbvy': 8, 'rotation_rbvz': 8}}

* Go to the online ANS, on the left side menu bar, click “Devices”’->"OpenRTK”, then we will have the “Open-

RTK Monitor” webpage as shown below, and the center “Play” button is highlighted indicating correct device
connection with the Web GUI,

° « @ < B

« C @ developersaceinna.com, k )

OpenRTK Monitor  connec

© uPLOAD > PLAY
N

¢ Click “Play”, you will have a live web GUI showing positioning information, map presentation and associated
satellites information

© G % B OpeniTE Moni x + -2
€ 5 C & developersaceinna.com/devices/rk wx O
e

@ Getting Started >

AdminCenter & A .
n o=

OpenRTK Monitor connecTeD @ DEVICE INFO

A |
© Devices v
Navigation Information <
GesTime
GPS Week 2094 )
Time of ek 10975310

Position
Mode RTKFXED

@ RTK Network Lotitude 31.50871208

>
Longitude 12040155650

¥ Simulation >
Enipsoidal H n9s6m
Code > MSL Helght 0000m
0.004m

= Forum >
B News > DoPPLER

© Glowass = saBS

RMS Piich

RMS Heading 0000 deg

6. Data Logging and Parsing: when the device is connected with the PC via the micro-USB cable, the run-
ning Python driver is logging all serial port output into files, including raw GNSS/IMU data, position-

ing solution and the device configuration. These files are located in a subfolder labelled “.pythondriver-
windataopenrtk_log_XXXXXXXX_XXXXxX", €.g.

2.2. Quick Setup and Usage 15
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# This PC » Local Disk (T} » pythondriver-win » data » openrtk_log_20201217_141618

Mame Date modified

5

configuration.json 1271772020 216 PM

(%] rtern_base_2020_12_17_14_16_18.bin 12/17/2020 2:21 PM

loads [55] rtcrn_rover 2020 12_17_14_16_18.bin 12/17/2020 2:21 PM

[55] user_2020_12_17_14_16_18.bin 12/17/2020 2:21 PM
I=
which,

* configuration.json: is the device configuration information

e rtcm_base_xxxx_xx_xx_xx_xx_xx.bin: is the received GNSS RTK correction data through internet,
in RTCM format

e rtcm_rover_ XXXX_XX_XX_XX_xX_xx.bin: is the GNSS raw data from the device, in RTCM format

* user_XxXXX_XX_XX_xX_xx_xx.bin: is the output from the USER UART, including NMEAO183 mes-
sages in ASCII format, raw IMU data and GNSS RTK/INS solution in binary format

Go to the “openrtk_data_parse” subfolder, run the parser executable as below

cd c:\pythondriver-win\
.\ans-devices.exe parse -t openrtk -p ..\data\openrtk_log_20201217_141618

A subfolder with the name “user_xxxx_XX_xX_XX_XX_xX_p” is created and contains the decoded files all in ASCII
format, e.g.

Marme Date modified Type Size

| | user_2020_12_17_14_16_18.nmea 12/18/2020 2:16 PM MMEA File 46 KB

@ user_2020 12 _17_14_16_18_gl.csv 12/18/2020 2:16 PM Microsoft Excel C... S0 KB
user_2020_12_17_14_16_18 sl.cav 12/18/2020 216 PM Microsoft Excel C... 3,003 KB
user_2020_12_17_14_16_18_yl.csv 12/18,/2020 2:16 PM Microsoft Excel C... 424 KB

which:
* USer_XXXX_XX_XX_XX_xX_xx.nmea: contains the GGA and RMC NMEAO183 messages
e user_xxxx_xX_xx_xx_xx_xx_gl.csv: is the GNSS RTK solution
® user_XXXX_XX_XX_XxX_xX_xx_sl.csv: is the raw IMU data

* user_XXXX_XX_XX_xX_xx_xx_yl.csv: is the GNSS satellites information that are used in the solution

2.3 Note

This section presents a brief introduction and quick start on using OpenRTK330LI EVK for RTK and INS positioning.
Please refer to the remaining sections of this tutorial chapter to explore more on OpenRTK330LI’s features and its
usage.

2.3. Note 16



CHAPTER 3

How to Use OpenRTK330 EVK?

Note the usage of OpenRTK330 is described with the OpenRTK330 EVK. There are two types of user APP provided
to interact with both the module and a NTRIP server over the internet providing GNSS correction data for RTK
positioning:

* PC: using the Ethernet interface

— Ethernet connectivity between module and NTRIP server with a lightweight TCP/IP stack embedded in
firmware

— Module settings on positioning parameters and user configuration with a web GUI embedded in firmware

— Map and positioning information display on the online web GUI (“OpenRTK Monitor”) of Aceinna de-
veloper website

17
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developers site

Python driver

»
'

Q .
5.

. e N
_ L .
i o d
- © Internet
Server
OpenRTK330

* Android: the “OpenRTK” Android App with the following contents

Bluetooth connectivity to module

— 4G connectivity to NTRIP server

Map display with user trajectory and positioning infromation

Module settings on positioning parameters and user configuration

Y

9 - %
_ .
< < r
@ Bluetooth Internet l

OpenRTK330 Mobile Server

The following two subsections cover the detailed steps of using the two types of user App.

3.1 Witha PC

Using the OpenRTK330L EVK to evaluate the OpenRTK330L product with a PC requires

* access to the online web based Aceinna Navigation Studio (ANS) via the Micro-USB connection between the
EVB and the PC

¢ access to NTRIP server over the internet via a Ethernet connection between the EVB and the PC

3.1. WithaPC 18
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3.1.1 Usage

1. Power and data link

Connect the EVB with a PC using a Micro-USB cable, and the YELLOW LED (#12 on the EVB figure
above) flashes. The EVB is powered on, and four serial ports are established on the PC.

2. Antenna

Connect a GNSS multi-frequency antenna to the SMA interface (#2 on the EVB figure), the GREEN
LED (#12 on the EVB figure above) flashes if the incoming GNSS signal is valid

3. Network

There are two ways of for the OpenRTK330LI EVB gets access to internet:

¢ Use an Ethernet calbe to connect the EVB with a network router or switch, and then connect a PC to

the same router/switch using an Ethernet cable. The OpenRTK330LI EVB gets internet access and
assigned an IP address in the local network via DHCP.

» The other way is using an Ethernet cable to connect the EVB and the PC directly, which requires
internet sharing between the PC and the EVB. For example, with a Windows 10 PC,

— Go to Control PanelNetwork and InternetNetwork Connections, an Ethernet subnetwork is es-

tablished for the Ethernet connection between the EVB and the PC, e.g. “Ethernet 2 as shown
below.

& Network Connections

O
4~ & 5 Control Panel » Network and Internet > Network Connections v V| | Search Network Connections »p
Organize ~ = -~ [
— WLAN — Ethernet 4 — Bluetooth
.\',5 memsicnet, Shared .\',’ _, Network cable unplugged .\'

il Broadcom 802.11ac Network Ada... % @
L“- Ethernet 2
S
Realtek USB GbE Family Controller

-
E Not connected

Hillstone Virtual Network Adapter X Bluetooth Device (Personal Area ...

@

— Right-click “Ethernet 2”, and then click “Properties”, on the “Networking” tab, click “Inter-
net Protocol Version 4 (TCP/IPv4)”, configure the IP settings as follows: the gateway has to

be 192.168.137.1, and the subnet mask has to be 255.255.255.0, while the IP address can be
assigned to one that has not been taken in the network 192.168.137.xx.

— ot et

e P Wi ction Rename this connection View status of this connection
Sharing General
Connect using: You can get IP settings assigned automatically if your network supports
& Reattek USB GbE Family Controler 2.5 ;zpzzlt;{&c;m;;;\u::&:’;: need to ask your network administrator
r i .
Configure....
) < (O Obtain an IP address automatically
This connection uses the following items:
(@) Use the following IP address:
B Client for Microsoft Networks ~
I3 File and Printer Sharing for Microsoft Networks P address: [192 168 .137 . 55 |
= eduie
2 Lad ubnet mask: 255 .255 .255 . 0
.4 Intemet Protocol Version 4 (TCP/IPv4)
= VicrosoR Network Adapter TiuRiplexar Protocol efault gateway: 192 .168 .137 . 1
4 Microsoft LLDP Protocol Driver

. Intemet Protocol Version 6 (TCP/IPv6)
<

v
>

(® Use the following DNS server addresses:
Install ninstal

stal Properties Preferred DNS server: . . .
Description

Alternate DNS server: L
Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks. [ validate settings upon exit Advanced...

oK Cancel i

Cancel

— Then, right-click WLAN (assuming the PC uses WiFi for internet access), go to Properties-
>Sharing, check the “Allow other network users to connect through this computer’s internet

3.1. WithaPC 19



OpenRTK Documentation

connection”, and select “Ethernet 2” on the drop down menu below, click “OK” to enable the
EVB to have access to internet shared by the PC.

— - —

-

d Networking Sharing
[
Intemet Connection Sharing

llow other network users to connect through this
omputer's Intemet connection

Home networking connection:

|]E:heme12—\|

Allow other network users to control or disable the
shared Intemet connection

Settings...

0K Cancel

4. Device Configuration on the Embedded Web Pages

A lightweight TCP/IP web service is embedded inside the OpenRTK330 firmware, user can access the
device configurations on the embedded web pages when the device and the PC are in the same local
Ethernet network (connected to the same router or direclty connected). Open a browser (Google Chrome
is recommended), visit http://openrtk,

* You will firstly see the following device running status page

@ OpenRTK x o+

< @ @ A== | openrtk/runStatus shtml * O

MENU Running Status

Running Status GENERAL: GPS Time INS
Work Configuratiof Station Mode- GPS Week 2136 INS Status: INS_INACTIVE
NTRIP-CLIENT Time of Week(s): 368602.00 INS Position Type: INS_RTKFIXED
INS Configuration Station Status:
Can Configuration NTRIP-CLIENT & RTCM AVAILABLE Position Velocity
. Mode: RTK_FIXED Vel Mode: DOPPLER
User Configuration Latitude(): 31.40444552 North(m/s): -0.002
Ethernet Configuration Longitude(®) 120.36282419 East(m/s): 0.004
Height(m): 119.227 Ui / 0.005
Device Info eight(m) p(mis)
Number of SVs: 23
HDOP: 06 Attitude
AGE(s) 20 Roll(*). 0.000
Pitch(°). 0.000
Heading(°): 0.000
Satellites

BDS(12):1.4,6,7.9,10,16,21,22,26 29,36
GPS(7):10,22,25,26,29,31,32
GLO(5):3,4,5,14,15
GAL(5):1,4,19,21,31

Besides the positioning information, this web page displays the working mode and status of the
device on the most left-upper conner,

— Station Mode, has the following two values:

* NTRIP-CLIENT: the device works as a NTRIP client (Rover), and is used as a position-
ing/navigation equipment
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*

NTRIP-SERVER: the device works as a NTRIP server (Base), and broadcasts its GNSS
data to NTRIP clients for differential GNSS operation

and the mode changes when the user configures the device differently in the “Work Configura-
tion” tab.

— Station Status, has the following thirteen values:

*

*

*

*

“Waiting. .. ”: waiting for changes to take effective
“NTRIP-CLIENT & CONNECT..."”: trying to connect with a NTRIP server
“NTRIP-CLIENT & CONNECT FAIL”: failed to connect with a NTRIP server

“NTRIP-CLIENT & CONNECTED”: connect with a NTRIP server successfully, waiting
for GNSS correction data

“NTRIP-CLIENT & RTCM AVAILABLE”: received GNSS correction data successfully
from the NTRIP server

“NTRIP-SERVER & CONNECT..."”: trying to connect with a NTRIP caster
“NTRIP-SERVER & CONNECT FAIL”: failed to connect with a NTRIP caster

“NTRIP-SERVER & CONNECTED”: connect with a NTRIP caster successfully, waiting
to output GNSS correction data

“NTRIP-SERVER & RTCM OUTPUT”: outputting GNSS correction data

“OpenARC CONNECT...”: trying to connect with Aceinna’s OpenARC cloud service
(e.g. NTRIP server and data service)

“OpenARC CONNECT FAIL”: failed to connect with Aceinna’s OpenARC cloud service

“OpenARC CONNECTED”: connect with a Aceinna’s OpenARC cloud service success-
fully, waiting for GNSS correction data

“OpenARC RTCM AVAILABLE”: received GNSS correction data successfully from
Aceinna’s OpenARC cloud service

* On the left side menu bar, click “Work Configuration” tab to choose the following working mode of
the device and configure it accordingly:

— Rover: works as a nomarl GNSS positioning device that is also referring to “NTRIP client”,
and receives GNSS data correction from a NTRIP server that has to be configured with the
following information, as shown by the “OpenARC Client” tab below

*

*

*

*

*

IP: openarc.aceinna.com
PORT: 8011

Mount Point: RTK

User Name: username

Password: password

3.1. WithaPC
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@ OpenRTK X 4+
& C ©® == | openrtk/op

Aceinna OpenR
MENU Work Config

|

Running Status
ROVER

Work as rover station. CpesARCICHENT

Work Configuration
User can choose
INS Configuration EJIThEr‘Fr,ngI:;‘eENT or IP openarc.aceinna.com
PORT: 8011
Can Configuration
MOUNT POINT:  [rtk
User Configuration USER NAME test
BASE PASSWORD 123455

Ethernet Configuration

Work as base station

with NTRIP SERVER

Device Info mode. Position can be m
reference pos set by

user or SPP/RTK

average result

OpenARC is a cloud service provided by Aceinna for users in the United States to receive
nation-wide GNSS correction data for RTK operation, without the need to set up a local GNSS
base station. More details refer to the section “OpenARC Service” (click here) in this tutorial.

— Base: works as a GNSS reference station with known position and sending GNSS data to
“NTRIP server” to be used as GNSS data correction

5. Live Web GUI on the Online ANS Website

Download (click here) the latest Python driver executable (v2.2.4 and later), and run it in a command line,
for example:

cd c:\pythondriver-win
.\ans-devices.exe

* Check the console output, the Python driver connects the device and the online ANS website, if
successfully, the following connection information is displayed

B Administrator: cmd * v _ o x

Microsoft Windows [Version 10.8.18362.53]
(c) 2019 Microsoft Corporation. All rights reserved.

C:\Users\Administrator>cd c:\pythondriver-win

c:\pythondriver-win>ans-devices.exe
Python driver version: 2.2.3

Prepare to find device...

Websocket server is started on port 8eee

OpenRTK log GNSS UART COM12

OpenRTK log DEBUG UART COM13

{'openrtk configuration': {'Product Name': 'OpenRTK336L', 'Product PN': '5020-3021-81 23.80.82', 'Product SN': 197580008
5, 'Version': 'RTK_INS App v23.00.02', 'pri_lever_arm_bx': 6, 'pri_lever_arm_by': 0, 'pri_lever_arm_bz': ®, 'vrp_lever_a
rm_bx': 8, 'vrp_lever_arm_by': 8, 'vrp_lever_arm_bz': 8, 'user_lever_arm_bx': 8, 'user_lever_arm_by': 8, 'user_lever_arm
_bz': @, 'rotation_rbvx': @, 'rotation_rbvy': @, 'rotation_rbvz': e}}

* Go to the online ANS, on the left side menu bar, click “Devices”->"OpenRTK”, then we will have
the “OpenRTK Monitor” webpage as shown below, and the center “Play” button is highlighted
indicating correct device connection with the Web GUI,

3.1. WithaPC
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OpenRTK Monitor connect

* Click “Play”, you will have a live web GUI showing positioning information, map presentation and
associated satellites information

Admin Center

OpenRTK Monitor connecTeD @ DEVICE INFO RTK My n =

* GLowass ¥ Beidou @ Galileo

6. Data Logging and Parsing on a PC
* With the UART/Serial port

When the device is connected with the PC via the micro-USB cable, the running Python driver is logging all
serial port output into files, including raw GNSS/IMU data, positioning solution and the device configuration.
These files are located in a subfolder labelled “.pythondriver-windataopenrtk_log_XXXXXXXX_XXXXXX", €.g.

» This PC » Local Disk (C:) » pythondriver-win » data » openrtk_log_20201217_141618

Fat
Mame [Drate modified
it
configuraticn.json 12/17/2020 216 PM
[%] rtem_base_2020_12_17_14_16_18.bin 12/17/2020 2:21 PM
loads [%] rtem_rover_2020_12_17_14_16_18.bin 12/17/2020 2:21 PM
(2] user_2020_12_17_14_16_18.bin 12/17/2020 2:21 PM
Is
which,

— configuration.json: is the device configuration information
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— rtecm_base_xxxx_xX_xx_xx_xx_xx.bin: is the received GNSS RTK correction data through in-
ternet, in RTCM format

— rtcm_rover_XXXX_XX_XX_XX_XX_xxX.bin: is the GNSS raw data from the device, in RTCM for-
mat

— user_XxxxX_XxX_xXxX_xX_xx_xx.bin: is the output from the USER UART, including NMEAO0183
messages in ASCII format, raw IMU data and GNSS RTK/INS solution in binary format

Go to the “openrtk_data_parse” subfolder, run the parser executable as below

cd c:\pythondriver-win\
.\ans-devices.exe parse -t openrtk -p ..\data\openrtk_log_20201217_141618

A subfolder with the name “user_xXxx_XX_XX_XX_XX_XX_p~ is created and contains the decoded files all in
ASCII format, e.g.

Mame Date modified Type Size

| | user_2020_12_17_14_16_18.nmea 12/18/2020 2:16 NMEA File 46 KB

!@ user_2020_12_17_14_16_18_gl.csv 12/18 : Microsoft Bxcel C... 50 KB
user_2020_12 17 _14_16_18 =sl.csv 12/18/2020 216 PM Microsoft Excel C... 3,003 KB

!@ user_2020_12_17_14_16_18_yl.csv 121872020 216 PM Microsoft Excel C... 424 KB

which:

user_XxXxXX_XX_XX_XX_xX_xx.nmea: contains the GGA and RMC NMEAO0183 messages

user_xxxx_Xx_xX_xx_xx_xx_gl.csv: is the GNSS RTK solution

user_XXXX_XX_XX_XX_xX_xx_sl.csv: is the raw IMU data
— user_XXXX_XX_XX_xX_xxX_xx_yl.csv: is the GNSS satellites information that are used in the solution
¢ With the CAN Interface

User could use a CAN-USB (e.g. https://canable.io/) or CAN-TTL adapter to connect with the DB-9 male
interface on the EVB to log and parse the CAN messages (click here for definitions). Note that user has to write
their own CAN message parsing code using the provided lib or open-source code from the adapter provider.

3.2 With an Android Smartphone

Using the OpenRTK330L EVK to evaluate the module requires
* the installation the “OpenRTK” Android App: provides 4G access to NTRIP server over the internet

* Micro-USB connection to a PC for power and data logging connection

3.2.1 “OpenRTK” App Installation

1. Scan the QR code below or click here to download the Android apk installation file. Make sure your Android
version is 8.0 or above.
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2. Open the downloaded APK file to install the App

Note: Please grant the OpenRTK App access to run in Android system’s backend.

3.2.2 Usage Steps

1. Connection

Connect the OpenRTK330 EVB to a PC via a Micro-USB cable, then connect the EVB
with a GNSS antenna, checking the LED lights for working status

YELLOW: flashing light indicating GNSS chipsets is powered on with valid 1PPS signal
output

GREEN: flashing light indicating OpenRTK330L INS App is running correctly with valid
GNSS signal receiving

Enable “Bluetooth” function and “Location” access right for “OpenRTK” App on your
Anroid device

Open the “OpenRTK” Andorid App, as shown by the picture below, go to the “Connect”
tab and click the “search” icon (right bottom) to search for your device. If your Open-
RTK330 device is found, a Bluetooth device ID appears on the “Connect” list. By factory
setting, the Bluetooth device ID is “OpenRTK_<four digits>" and the four digits are the
last four digits of your OpenRTK330 module S/N. Click your Bluetooth device ID and if
connected successfully, a notification appears

3.2. With an Android Smartphone
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FREEGE D 46

el Sl

SNO3PN ®)12:55

" Connected to device OpenRTK_0201

/ OpenRTK_0201 <80:7D:3A:B5:89:2E>

OpenRTK_0001 <50:7D:3A:B5:BFBE>
OpenRTK_0095 <80:7D:3A:B6:02:EA>
OpenRTK_0086 <50:7D:3A:B4:62:EA>

OpenRTK_0205 <98:2¢:BC:33:1D:E0>

3 - o \3)

CONNECT LOG MAP NTRIP

* Besides, detailed Bluetooth connection and user configuration information of the device can be

found on the lower window of the “Log” tab, and NMEA GGA messages are reporting the Open-
RTK330 device position on the upper window of the “Log” tab.
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EIPRED fe il Sl = SNO3R ®W)13:03

Logs

All Logs

2020-02-27T13:03:45+08:00: NMEA: SGPGGA,
050346.50,3130.5226505,N,12024.0934779,E,
1,34,1.0,27.813,M,0.000,M,0.0,*4A

2020-02-27T13:03:45+08:00: NMEA: SGPGGA,
050346.00,3130.5226505,N,12024.0934779,E,
1,34,1.0,27.813,M,0.000,M,0.0,*4F

2020-02-27T13:03:45+08:00: NMEA: SGPGGA,
050345.50,3130.5226793,N,12024.0942753,E,
1,31,0.4,25.154,M,0.000,M,0.0,*45

Connect Logs

2020-02-27T13:01:59+08:00: GET DATA FROM
BLUETOOTH: {
"openrtk config": {

"Product Name”: "OpenRTK330L",
"Product PN":"8350-3021-01 0.1.0",
"Product SN":1975000201,
"Version": "OpenRTK330L INS App 0.0.7",
"Compile Time":"Feb 26 2020",
"userPacketType":"e1",
"leverArmBx":1.400000,
"leverArmBy":-0.250000,
"leverArmBz":-1,

3 - 7] \3)

CONNECT LOG MAP

2. Map Presentation

* Once the Bluetooth connection made successfully, and OpenRTK330 is reporting positioning infor-
mation to Android App, go to “Map” tab and click “Start Live Data” to start a live map presentation
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SNORN ®13:16

R ERE O 46
e el =

= Map

START LIVE DATA

@ mapbox
3 @ 2

CONNECT LOG

* Real time positioning information and trajectory is shown

\3)
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LD el e = SNOZR ®@)13:15

= Map

Latitude: 31.50871214 UTC Time: 051541.30
Longitude: 120.40155655 Satellites: 28
Height: 31.955

Heading:
Solution: FIXED

B .

PAUSE

@O mq 3
3 ~

CONNECT

3. NTRIP Configuration

¢ In order to get GNSS RTK positioning, go to “NTRIP” tab and configure the NTRIP server settings of your
GNSS correction data provider
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o o 45 all Sl SR O3N §113:32

= NTRIP

IP 106.12.40.121

Port 2201

Mount Point RTK

User Name AceinnaRTK|

Password 555555

Pull Base )

SAVE

3 ~) 7] \3)

CONNECT LOG MAP NTRIP

¢ Click “SAVE” to save your NTRIP server settings to your OpenRTK330 module, and then switch on “Pull Base”
to get GNSS correction data for RTK
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el .l = SRNO3N §)11332

H B
HE#

= NTRIP

IP 106.12.40.121

Port 2201

Mount Point RTK

User Name Rtkdrive
Password 555555

Pull Base @) BASE DATA OK

SAVE

23 - 7] \3)

CONNECT LOG MAP NTRIP

4. User Configuration.

From anyone of the four tabs, you can access the menu for user configuration by clicking the icon “’ at
the upper left corner
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e ll “all SRIORN 81342

OpenRTK

¢  Device Advanced

t Developer Option

APP Version
1.6.7

* Click “Device Advanced”: user can change and save OpenRTK330 device settings, like Bluetooth
ID, lever arm and so on.
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e ol all SRNO PR @)13:45

< Custom Setting

LeverArmBx: 1.4

LeverArmBy: -0.25

LeverArmBz: -1

PointOfInterestBx: 1.4

PointOfinterestBy:  -0.25

PointOfInterestBz: -1

RotationRbvx: 0

RotationRbvy: 0

RotationRbvz: -90

SAVE

* Click “Developer Option™: user can configure the Android App on map presentation and switch
on/off of saving positioning results (NMEA GGA messages only) to Android phone storage. The

defualt storage path is “Android/data/com.aceinna.rtk/files/log”

3.2. With an Android Smartphone
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PEBE D 4
hEBEH D "

ill ol = SNO3ZR ®@)13:46

< Debug Mode

Save Result @@
Auto rotation .

Show line

skip O

Keep points 5000

SAVE

5. Data Logging

In the mobile use case, user still needs a PC to log the device output data into files, the OpenRTK Android
app doesnot log data on the phone. Refer to the previous section “With a PC” for data logging details.

3.3 EVK Vehicle Installation

3.3.1 Reference coordinate frames
In order to install the OpenRTK330 EVB on vehicle for driving test, a few reference frames listed below has to be
defined

e The IMU body frame is defined as below and shown in the figure. By default the INS solution of
OpenRTK330 is provided at the center of navigation of the IMU (refer to the mechanical drawing
for accurate IMU navigation center position on the EVB).

* x-axis: points to the same direction as the SMA antenna interface
 z-axis: perpendicular to x-axis and points downward
 y-axis: points to the side of the EVK and completes a right-handed coordinate system

¢ The vehicle frame is defined as
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— x-axis: points out the front of the vehicle in the driving direction
— z-axis: points down to the ground

— y-axis: completes the right-handed system

Longitudinal

Vertical
z

¢ The local level navigation frame is defined as
— Xx-axis: points north
— z-axis: points down parallel with local gravity
— y-axis: points east

* The user output frame is used to transfer the INS solution to a user designated position.

3.3.2 Installation Parameters

Depends on the vehicle installation of the OpenRTK330 system, user has to configure two types of offsets to make the
GNSS integrated INS solution work

¢ Translation offset

— GNSS antenna lever-arm: GNSS position is estimated to the phase center of the GNSS antenna,
and INS position is estimated to the center of the navigation of the IMU. The translation from
the IMU center to the phase center of the GNSS antenna has to be known and applied to the
integrated system via user configuration of the antenna lever-arm. The GNSS/INS integrated
solution outputs position at the IMU center. For example, the lever arm in the figure below is
[x,y, z] =[-1.0, -1.0, -1.0] meter.
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X Offset

/ﬁ
X
=L,

X Offset

— User output lever-arm: If user wants the above GNSS/INS integrated solution output at a more
useful position, the translation between the IMU center and the designated point of interest has
to be known and applied via user configuration of point of interest lever-arm.

Rotation offset: If the axes of the IMU body frame of the installed OpenRTK330 unit is not aligned
with the vehicle frame, the orientation of the IMU relative to the vehicle also has to be known and
applied via user configuration of rotation angles between the IMU body frame and vehicle frame.
For example, given a installation setup as shown by the following figure

We have to mathematically rotate the IMU body frame to align with the vehicle frame, in the
following order:

1. Rotate IMU cooridnate frame to get z-axis aligned
2. Rotate IMU cooridnate frame to get x-axis aligned
3. Rotate IMU cooridnate frame to get y-axis aligned

For the example above, firstly rotate 90 degrees clockwise along IMU y-axis to align z-axis of
two frames,

Then rotate 90 degrees counter-clockwise along IMU z-axis to align x-axis of two frames.

The final rotation matrix angles that user has to configure are [X, y, z] = [0, -90, 90] degrees.
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3.3.3 Odometer Input from Vehicle

ZVehicIe

YVehicIe

X‘Ve hicle

XIP\."IU

To fully explore the dead reckoning (DR) for vehicular positioning, OpenRTK330LI EVK has the following three

options to get the Odometer data input from the vehicle:

¢ CAN interface

» wheel-tick signal and FWD (i.e. forward) signal

e USER UART input message
CAN interface

User is recommended to use a OBDII-CAN cable to connect the EVB DB-9 interface with one OBDII
interface on the vehicle, the following photos show an example

3.3. EVK Vehicle Installation
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The CAN message contains vehicle Odometer speed data is different among manufacturers, Open-
RTK330LI EVK provides user configuration on the internal Web interface (https://openrtk) to accom-
mondate the different input CAN messages, as shown below

[ OpenRTK E .

<« C @ # =222 | openrtk/OdoConfig.cgi % @

Embedded webserver

NTRIP Setting

User Configuration
CAN Message Mode

IStartbit  |Length  [Endian Sign Factor Offset Source

lao 16 i o 0.01 -6767 o o

56 16 il o 0.01 -6767 o 1

Odo Configuration

Ethernet Setting

Device Info
on 230 Man
OpenRTK330 Manual Value

32
16

Hardware Mode

PIN Mode: ® WHEELTICK © SPI_NSS
CAN Mode: O CAR ®]1939

User has to check the “CAR” option for the CAN mode to enable the data input working mode of the
CAN interface, as shown in the red circle. In the table above, user input the following fields to configure
how the OpenRTK330LI module should parse the incoming Odometer message from CAN bus:

e MesgID: CAN message ID, decimal value

e Startbit: the number of starting bit of the Odometer data
* Length: the Odometer data Length in number of bits

* Endian: O - little endian; 1 - big endian

e Sign: 0 - unsigned; 1 - signed

3.3.

EVK Vehicle Installation
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* Factor and Offset: actual Odometer value = (original value + Offset) * Factor
e Unit: 0 - km/h; 1 - mph; 2 - m/s

¢ Source:

0 - right-rear wheel speed (RR)

1 - left-rear wheel speed (LR)

2 - vehicle speed (combined)
— 3 - gears: fill-in the gear (P, R, N, and D) value in the table below
There are two options to input the vehicle speed depending on the Odometer CAN messages,
* Configure the source to have RR and LR enalbed to obtain aveaged real wheel speed
» Configure the source to have a single combined vehicle speed
and the first option above is recommendded.
USER UART interface

With this approach, user need to extract vehicle speed information from the CAN bus or the wheel speed
encoder and send in the real vehicle speed value through the USER UART, using the “cA” packet de-
scribed in the USER UART data protocol section.

Wheel-tick encoder interface

Another approach to integrate vehicle speed for DR is shown below. A typical aftermarket wheel-tick
encoder is shown on the left. Note that OpenRTK330LI EVB currently only supports one wheel-tick
encoder input. As shown by the right side photo below, the phase-A and phase-B should connect with
the #47 and #48 jumper on the EVB, respectivelly. The input voltage for the pins of OpenRTK330LI
EVB is 3.3 v, if the wheel-tick encoder output voltage does not fit, user has to bring in additional voltage
conversion circuits or module.

In the current design, the wheel-tick input processing takes over the interrupter of the MCU from the SPI
communication ports, thus user needs to choose one of two working mode on the internal web interface
page, as shown by the red circle in the figure below
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[ OpenRTK x o+

< C @ F== | openrtk/OdoConfig.cgi % e

Aceinna OpenRTK

User Configuration Embedded webserver
Odo Configuration

Setting CAN Message Mode

Etherne

Device Inf Startbit Factor Offset Unit Source
bevice nio 140 0.01 -6767 o o

56 1 -6767 o il
OpenRTK330 Manual e &) o

Value
32
16
8
0

Hardware Mod

PIN Mode: © WHEELTICK ® SPI_NSS
CAN Mode: ® CAR ©J1939
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CHAPTER 4

Firmware Online Upgrade

Contents

*» WARNING!!!

» Firmware Upgrade Online

4.1 WARNING!!!

I. SAVE BEFORE DEVELOPMENT START: it’s strongly recommended to save your factory OpenRTK330
module system image file to a binary file to be able to recover the whole system if something unexpected
happened! Especially, if the system bootloader and IMU calibration tables are damaged, OpenRTK330 will not
work properly.

» Save system image

1. Download and install ST-Link Utility from here

2. Connect ST-Link debugger between OpenRTK330 EVB and PC and power on the EVB
3. Open ST-Link Utility software on the PC and go to Target->Connect
4

. Enter value 0x08000000 in Address box and 0x100000 in Size box as shown by the figure below, then hit
enter

5. Click File->Save As to save the system image file

* Recover system image
1. Connect ST-Link debugger between OpenRTK330 EVB and PC and power on the EVB
2. Open ST-Link Utility software on the PC and go to Target->Connect
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U, STM32 ST-LINK Utility - | b
File Edit View Target ST-LINK External Loader Help

Hdl @& L BT

Memory display Device STM32F469x/F479x%
- . Device ID 0434 F
Address; (008000000 | Size: [ 0x100000 | Data Widih: nevnD | RevA |
Flash size 1MBytes
Device Memory @ 0x02000000 :  Binary File [LiveUpdate
Target memary, Address range: [0x08000000 0x08100000]
Address |0 |4 E lc | asci A
0x08000000 20050000 08001149 08003EB5 08003EE1 ST PR 2 S PN
008000010 0B003EFB 0B003EFD 0B003EFF 00000000 s ... P
008000020 00000000 00000000 00000000 0B0011BE  |..cecvavee.n A

0x08000030 08003F01 00000000 080011B9 08003F03

008000040 080011B9 08001189 080011B9 080011B9

008000050 080011B9 08001189 08005AF1 08001189

0x08000060 080011B9 | 080011B9 080011B9 | 0BOOGBEB 2..2..%..%h..

0x08000070 0800G8FF | 080011B9 | 080068D7 | 0B0011B9 ho.%..7%h..%.. v

Rr=r=y
: Connected via SWD.

: SWD Frequency = 4,0 MHz

10:08:50 : Connection mode : Connect Under Reset.

10:06:50 : Debug in Low Power mode enabled.

10:06:51 : Device ID:0x434 |

10:06:51 : Device fiash Size : IMBytes

10:06:51 : Device family :5TM32F46%F479x

10:08:22 : File saved as C:\Users'zouyundong\Desktop\Fw 1.bin
10:09:01 : File saved as C:\Users'zouyundong\Desktop\F 1.bin

bebug in Low Power mode enabled, bevice ID:0x434

3. Click File->Open and open previously saved image file

4. Click Target->Program & Verify and make sure that the start address is 0x08000000 before you click Start
button to re-programming the OpenRTK330 module

5. Click Target->Option Bytes and select “sector 07, “sector 17, “sector 2”, “sector 3" and “sector 11 to
perform write protection. Click Apply button for make it effective.

4.2 Firmware Upgrade Online

Work with the online App Center of ANS (click here) to install/update the OpenRTK330 module firmware, as
shown by

First, upgrade OpenRTK330LI bootloader (to v1.1.1 and later, Win10 only):
1. Connect ST-LINK debugger between a PC and the EVB
2. Use a Micro-USB cable to connect the PC and the EVB and power on the EVB
3. Download the Bootloader bin file from the App center as shown by the above figure
4

. Open ST Utility software, click Target->Connect, then click Target->Program & Verify, on the pop dialog as
shown below, load the downloaded bootloader bin file from step 3, check “Verify while programming” and
“Reset after programming”, click “Start” button
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Download [ FW1.bin ] %

Start address | 0x08000000

File path |E:"wL| sershzoupundongDesktopiFw.bin Browse
Extra options

[ ] Skip Flash Erase [ ] Skip Flazh Pratection verification
Yerification

(@) erify while programming () Werify after programming

Click "Start" to program target.

After programming
Reset after programming [ Full Flash memory Checksum

Start

5. Remove ST-LINK debugger from the EVB
Secondly, follow the steps below to upgrade OpenRTK330 firmware:

1. Click here to download the latest Python driver (v2.3.0 and later), e.g. “pythondriver-win.zip” for
Windows 10

2. Unzip the Python driver on a PC, and run the excutable file “ans-devices.exe” in a command line,
e.g.

c:\pythondriver-win\ans-devices.exe

3. Upgrade OpenRTK330 INS App

* Power on the EVB via connecting a Micro-USB cable between the EVB and a PC, the
YELLOW LED starts flashing

* The python driver keeps scanning available serial ports to connect with OpenRTK330, if
connected successfully, you will see the following console output

* On the above App Center webpage, click “GNSS_RTK_INS” App, and then click the
highlighted “UPGRADE” button, the YELLOW LED stops blinking and the GREEN
LED starts blinking quickly

* Upon finishing, you will see the dialog below on the App Center webpage. USER DO
NOT have to do any operation, wait for the YELLOW LED to recover blinking. The
GREEN LED will start blinking if connected to a GNSS antenna with valid signal receiv-

ing
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| Option Bytes X
Read Out Protection EOR Level
Level 0 v F |OFF v|R
Uszer configuration option byte
WwWDG_STOP wWDG_STDEY nBootld nBOOTO
WwWDG_SW wDG_LULP nBootl BOOT1
nSRak_Parity FZ_IWDG_STOP nDBOOT [ ]BFB2
SRaMZ_RST FZ_IWDG_STDBY nDBAMNK nBOOT_SEL
SRAMZ _PE PCROP_RDP [ 1DB1M DUALBANEK
nAST _SHDW nBoot0_Sw Cfg IRHEM BOREN
] nRST_STOP nSWBOOTO MWDG_SW
i nRST_STDBY VDDA _Monitor SDaDC12_VDD_Monitor
] NRST_MODE
Security option bytes
SEC_SIZE 0x00 SEC_SIZEZ 0x00 BOOT _LOCK
- Boot address option bytes
! BOOT_aDD0H) Boot from (H]
]
b BEOOT_aDD1 (H) Boot from (H]
Uszer data storage option bytes
Data O[H] Data 1 [H)
Flash sectors protection
Flazh protection mode: "Wirite protection v
Sector Start address  Size Frotection ’
[ Sector 0 0x08000000 16K ‘Wrhte Protection
[v] Sector 1 002004000 1B K Write Protection
[~ Sector 2 0x08008000 16K ‘Wirite Pratection
Sector 3 0=0800C000 ek dbiaibn Clendin s
[] Sector 4 ox08010000 | S€lect page(s) to protect
[] Sector 5 008020000 128K Mo Protection
[] Sectar 6 Ox08040000 128K Mo Protection
[] Sectar 7 Ox08080000 128K Mo Pmotection
[] Sector 8 008020000 128K Mo Protection -
'_l -~ " Em’ En I T T ML R T T ] -, - L] . "
< >
Unzelect all Select all
' Apply Cancel
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46



OpenRTK Documentation

Apps X +
A

@ developers.aceinna.com/code/apps ® w ‘ ]

(B T

(D Getting Started )

App Center OFFICIAL | PUBLIC  PRIVATE = FILTER
@ Devices
& RTK Network DEMO RAWDATA Buo loader GNSS RTK NS
# Simulation
Mar-16-2020 May-14-2020 Aug-19-2020 Aug-19-2020
i Code OpenRTK330L
0 Apps
Download [ OpenRTE330L_Bootloader_v1.7.1.bin | *
Start address | 0=08000000
File path | C:\DpenRTK330L_Bootoader_v1.1.1.bin Browse
Extra options
[ Skip Flash Eraze [ Skip Flash Pratection verification
Yerifization
(®) Yerify while programming () Werify after programming

Click "'Start" to programm target,

After pragrarmmming
Fezet after pragramming [ Full Flash memory Checksum
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(A E:\bin\pythondriver-uin 2.1 S\ans-devices.exe

gr 15
d Information

B ~res x  +

<~ c & developers.aceinna.com/code/apps

OpenRTK330L - GNSS_RTK_INS | v2.0.0 v
ﬂ Update Time: 2020-08-19 17:13:01

Author: dw-gnss-aceinna

Description

ST Teseo V SDK w5.8.11
Unified single firmware

Added wheel-tick encoder derived speed data support
Works with Python driver v2.x.x

L

UPGRADE

Download .bin

4.2. Firmware Upgrade Online
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Upgrade operation is finished, your device is updated

4
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CHAPTER B

OpenARC GNSS Correction Service

Contents

e Introduction

* Usage with the OpenRTK330LI Module

5.1 Introduction

OpenARC is Aceinna’s precise positioning platform that offers easy system integration of GNSS corrections with
high performance GNSS RTK/INS hardware. OpenARC provides secure GNSS corrections powered by a dense RTK
network nation-wide over the United States and a cloud-based architecture.OpenARC offers performance (<10 cm
accuracy with no latency), security and integrity (fault tolerance and encryption) and flexibility, while being cost
effective.

OpenARC service is inherently supported by the OpenRTK330LI navigation module and its cloud service interface is
embedded in the module firmware, and provides a vertically integrated and seamless positioning platform for industrial
and autonomous vehicle applications.

5.2 Usage with the OpenRTK330LI Module

1. Register an OpenARC user account

a. Go to https://openarc.aceinna.com, click “Sign Up” to register an account.

50


https://openarc.aceinna.com

OpenRTK Documentation

b.

On the Sign Up page, enter the user name, email, password and confirm password to register, or
directly use your GitHub account to register

Sign Up

2. Create GNSS correction service account

a.

Login your OpenARC user account, click on your username that is located on the right-upper corner
of the web page, then click on “RTK credentials”

. On the “Create RTK Credentials” webpage, create a username and password for your GNSS correc-

tion data service, which will be used as the “username” and “password” for a typical NTRIP setting,
e.g.
* [P Address: openarc.aceinna.com

PORT: 8011
e Mount Point: RTK

e User Name: username

e Password: password

3. Subscribe correction service

a.

On your OpenARC account webpage, click “Subscriptions” on the left side menu, and then click the
“Add” button to create a new data service subscription,

5.2. Usage with the OpenRTK330LI Module
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[im]

e

RTK Credentials

Subscriptions

Devices

Subscriptions

Orders

Profile

Networks

=
0

openarc.aceinna.com

How it works Contact Tmm  Logout
TYPE QUQTA CREATION OPERATION
No Data

b. On the “Create Subscription” page, select the subscription type and modify the number of devices
that will be associated with this subscription, and then click “Submit” button to get to the payment

page,

w

Create Subscription

pice $399.00

c. Fill in your payment method information, and complete the OpenARC GNSS correction service

account creation and subsription.

4. Bundle your OpenRTK330LI device

a. On your OpenARC account webpage, click “Devices” on the left side menu, and then click the

“Add” button to start adding a device,

Devices

No Data

5.2. Usage with the OpenRTK330LI Module
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b. On the pop up window, enter your OpenRTK330LI device’s serial number manually. This step is
optional as OpenARC will associate your device with your subscription automatically when the
device is connected with OpenARC for the first time. Each OpenRTK330LI device has a service
trial time after you registered with OpenARC by default, which means during this time you can
perform RTK positioning with OpenRTK330LI device.

Add Device

+ Serial Number

c. Once your OpenRTK330LI device is associated your OpenARC account, for each device on the
device list you can click the “bind” button to bundle with your purchased RTK correction service

subscription.
e e ol ) S - 1 o I

@ARL‘. MNetworks How it works Contact T Logout
RTK Credentials Devices - .
Subscriptions
Devices

SERIAL NUM STATUS AVAILABLE ACTIVATION EXPIRATION OPERATION
Orders

0O o s Inactive Yes  A00T wanT @t
Profile
Prev . Next

@ openare.aceinna, com

Bind Device with subscription

* Subscriptions v
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The OpenRTK330LI Module

The Aceinna OpenRTK330 module integrates a ST Teseo V automotive grade multi-constellation, multi-frequency
Global Navigation Satellite System (GNSS) chipset (supports GPS, GALILEO, GLONASS, Beidou, QZSS), a triple-
redundant 6-axis (3-axis accelerometer and 3-axis gyro) MEMS Inertial Measurement Unit (IMU), and a ST M4
MCU as the processor. OpenRTK330 module is targeted for commecial applicaiton for the mass market that requires
a reliable, high-precision and yet cost effective GNSS/INS integrated positioning solution.

Features with:

* 100 Hz GNSS/INS integrated position, velocity and attitude solution

* Integrated tripple redundant 6-axis IMU sensors

* Integrated multi-frequency GNSS chipset with the following two frequency plans

GNSS L1/L2 plan L1/L5 plan
GPS L1C/A+L2C | L1C/A+1L5
GLONASS | G1 Gl
BeiDou B1I+ B2I B1I + B2A
Galileo El + E5b El + E5a
QZSS L1C+12C LIC+L5
* RTK algorithms on-board for up to centimetre accuracy
e UART / SPI/ CAN / Ethernet Interfaces
6.1 Technical characteristics
Accuracy’
Horizontal Position Accuracy (RMS)
SPS 1.2 m CEP
RTK” 0.02m

Continued on next page
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Table 1 — continued from previous page

10s GNSS Outage | 0.4m
Vertical Position Accuracy (RMS)

SPS 1.8 m CEP
RTK 0.03m

10s GNSS Outage 0.6 m
Velocity Accuracy (RMS)

Horizontal 0.02 m/s
Vertical 0.02 m/s
Heading Accuracy (RMS)’ 0.5°
Attitude Accuracy (Roll/Pitch, RMS) 0.1°
Operating Limits

Velocity 515 m/s
Acceleration 8¢g
Angular Rate 400 °/s
Temperature Calibration Range -40 °C to +85 °C
Timing

Time to First Fix"

Cold Start’ <60s
Warm Start® <45s

Hot Start <lIls
Signal Re-acquisition <2s

RTK Initialization Time <15s

INS PVA output rate 100 Hz
Sensitivity

Tracking -160 dBm
Cold Start -140 dBm
Environment

Operating Temperature (°C) -40 to +85
Non-Operating Temperature (°C) -55 to +105

Vibration IEC 60068-2-6 (5g)
Shock survival MIL-STD-810G (40g)
Electrical

Input Voltage (VDC) 27t055V

Power Consumption (W)

1.0 (Typical)

Digital Interface

UART, CAN, SPI, Ethernet

Physical

Package Type 50-pin LGA
Size (mm) 31x34x5
Weight (gm) 5

! Typical values, subject to ionospheric/tropospheric conditions, satellite geometry, baseline length, multipath and interference effects.

2 Add 1ppm of baseline length.

3 After dynamic motion initialization.

4 Typical values.

5 No previous satellite or position information.
6 Using ephemeris and last known position.

6.1. Technical characteristics
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Notes

6.2 Pin Definitions

i
&7

s

B o & OpenR T30
g8
= =
1! Gup = ANT SENSE (-2
L1 GND ANT_EN -2
GND LNA_EN [—=
GNI LTEZ PWR [
= VBAT e
= LED: ST_UARTI_RX [—5
— LEDI ST_UARTI_TX [
= ETH_RESET SWCLK 52
R Tx 0 SWINOD =
+ RMIL TXDI USER_UARTL TX ;+
] KRMICTH_EN USER_UARTI RX 5=
15 VDD_CORE CAN_TX =3
= VIN CAN RX [—5=
131 RMIIL_RXDN DEBUG RX |37
—=~ ETH_MDC DEBUG TX (=
] RMILRXDN ST LART PROG RX —5
15| RMILREF CLK ST_UART_PROG_TX |-
7o ETH_MDIO LTE2 TX 2
S BMILCRS By LTEZ kX o
T GMD GMD K
—= NS5 IPPS e LTEZ R5Tn
= E L :_';'i'
B gEs S5x ¢
gl—= %EEE!!E Ej|j| E'-E =
S2FEcEp2RZ2 Bopand EEES
worno S Sadmen g ==l s
FEEEER R PEEL:
b b e ] o [ F.'F"..'-T‘IE 31.’- ’-—.-"r"‘?.il’? '?.%??l?r’r
No. | Name Type | Description
1 GND P Ground
2 GND P Ground
3 GND P Ground
4 GND P Ground
5 VBAT P Reserved
6 LED2 (0] Status2 LED
7 LEDI1 (0] Status1 LED
8 ETH_RESET O Reset signal of ETH RMII interface
9 RMII_TXDO (0] Transmit dataO of ETH RMII interface
10 RMII_TXD1 O Transmit datal of ETH RMII interface
11 RMII_TX_EN O Transmit enable of ETH RMII interface
12 VDD_CORE P Reserved
13 VIN P Typical DC3.3V, input voltage DC3.0V~3.6V
14 RMII_RXD1 1 Receive datal of ETH RMII interface
15 | ETH_MDC (@) Management interface (MII) clock output
16 RMII_RXDO 1 Receive data0 of ETH RMII interface

Continued on next page
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Table 2 — continued from previous page

17 RMII_REF_CLK 1 Clock signal of ETH RMII Interface

18 ETH_MDIO 1/0 Management interface (MII) data I/O

19 RMII_CRS_DV (0] Carrier sense/receive data valid output of ETH RMII interface
20 GND P Ground

21 GNSS_1PPS I 1PPS signal from external GNSS module

22 GNSS_RTK_STAT 1 RTK status signal from external GNSS module

23 GNSS_RSTn (0] Reset signal to external GNSS module

24 GNSS_TX 1 Receive data from external GNSS module

25 GNSS_RX (0] Transmit data to external GNSS module

26 | DEBUG_NRST I Reset signal of MCU debug interface

27 | WIFI/BT_RESET o Rest signal for external WIFI/BT module

28 WIFI/BT_BOOT_CTL | O Boot mode select signal for external WIFI/BT module

29 USER_MOSI 1 SPI interface. Receive data from master

30 USER_SCK 1 SPI interface. Clock signal from master

31 USER_NSS I SPI interface. Chip selected signal from master

32 USER_MISO O SPI interface. Transmit data to master

33 LED3 (0] Status3 LED

34 ST _BOOT_MODE 1 Boot mode control signal for internal ST GNSS chip

35 WIFI/BT_UART2_RX | I Receive data from external WiFi/BT module

36 WIFI/BT_UART2_TX | O Transmit data to external WiFi/BT module

37 CAN_AB (@] CAN bus transceiver loopback mode control

38 CAN_120R_CTL O CAN termination resistor control (ON/OFF)

39 | USER-DRDY o Data ready signal

40 GND P Ground

41 LTE1 TX O Transmit data to external LTE module 1

42 LTE1_RX 1 Receive data from external LTE module 1

43 LTE1_PWR O Power control signal for external LTE module 1

44 | LTE1_RSTn (0] Reset signal of external LTE module 1

45 LTE2 _RSTn O Reset signal of external LTE module 2

46 GND P Ground

47 LTE2_RX 1 Receive data from external LTE module 2

48 LTE2_TX O Transmit data to external LTE module 2

49 ST _UART _PROG_TX | O Receive data from internal ST GNSS UART?2 (GNSS program burning)
50 | ST_UART_PROG_RX | I Transmit data to internal ST GNSS UART2 (GNSS program burning)
51 DEBUG_TX O Transmit data. DEBUG serial port

52 DEBUG_RX 1 Receive data. DEBUG serial port

53 CAN_RX 1 Receive data from CAN bus

54 CAN_TX (@] Transmit data to CAN bus

55 USER_UART1_RX 1 Receive data. USER port

56 USER_UART1_TX O Transmit data. USER port

57 SWDIO 1/0 Data IO of SWD debug interface

58 | SWCLK I Clock signal of SWD debug interface

59 ST_UARTI1_TX (0] Transmit data from internal ST GNSS UART1 port (debug data)
60 ST UARTI1_RX 1 Receive data to internal ST GNSS UART1 port (debug data)
61 1PPS o 1PPS signal

62 LTE2_PWR O Power control signal for external LTE module 2

63 | LNA_EN (0] Control signal of external LNA power

64 ANT_EN O Antenna enable, reserved

65 ANT_SENSE 1 Antenna sensing detection, reserved

66 | AGND P Internal GNSS RF path ground

Continued on next page
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Table 2 — continued from previous page

67

ANT_IN I GNSS antenna signal input

68

AGND P Internal GNSS RF path ground

6.3 Communication Ports and Operation

USER UART has serial port IAP (program firmware APP) function, ST UART PROG serial port is the serial port for
SDK firmware programming, users must connect. BT UART and ETH can pull base rtcm3 for RTK operation, users
need to choose at least one connection. Other interface users can connect according to their needs. The hardware
design can refer to OpenRTK330 EVK.

6.3.1 User Port

Pin: USER_UART_RX(#55), USER_UART_TX(#56)

Default configuration

Baud tare: 460800 b/s

Stop bit: 1

Data bits: 8

Check Digit: None

Data format: ACEINNA format, NMEA format

The main function

Obtain module information: hardware version number, software version number;
Obtain and configure module user parameters;

Send data packets: IMU raw data, positioning data, satellite data;
Send NMEA format data;

Function details

The following takes configuration parameters as an example to introduce how to use the ACEINNA for-

mat:
1) Send the “gA” command to the module to obtain all current user parameters:
gA command: [0x55, 0x55, 0x67, 0x41, 0, 0x31, 0x0A]

2) Use the “uP” command to modify the parameters:

uP command: [0x55, 0x55, 0x75, 0x50, data length, parameter number, parameter value,

CRC_L, CRC_H]

For example: configure the three parameters of leverArmBx, leverArmBy, leverArmBz to [0.5,
-0.5, 1] (unit m), you need to send the “uP” command three times, and the setting result will be
returned each time. After the last setting result is returned, send again Set the command next

time.

¢ Configure leverArmBx: [0x55, 0x55, 0x75, 0x50, 0x08, 0x04, 0, 0, 0, 0, 0, 0, Ox3F,

0x1D, 0x32]

¢ Configure leverArmBy: [0x55, 0x55, 0x75, 0x50, 0x08, 0x05, 0, 0, 0, 0, 0, 0, OxBF,

0xCB, 0x69]

6.3. Communication Ports and Operation
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* Configure leverArmBz: [0x55, 0x55, 0x75, 0x50, 0x08, 0x06, 0, 0, 0, 0, 0, 0x80, 0x3F,
0x89, 0x0C]

3) Use the “sC” command to save the parameter value:

sC command: [0x55, 0x55, 0x73, 0x43, 0, 0xC8, 0xCB]

Special Note

"initial":{
"useDefaultUart": 1,

"uart": [

{
"name": "GNSS",
"value": "comlO",
"enable": 1

}I

{
"name": "DEBUG",
"value": "comll",

"enable": 1
}
]I
"userParameters": [
{
"paramId": 4,
"name": "lever arm x",
"value": 0.0

"paramId": 5,
"name": "lever arm y",
"value": 0.0

}

The user serial port is the serial port connected by the python driver. If the user needs to enable the data log func-
tion or automatically configure user parameters when the python driver is started, first configure the “initial” field in
openrtk.json as shown in Figure above.

Use OpenRTK/OpenIMU python driver operation
1) Set the log serial port

[T L]

When the python driver is started with the “-r” suffix, the log function will be enabled and the data of the three
serial ports of USER, GNSS and DEBUG will be recorded at the same time. The USER serial port number can be
automatically identified by the python driver, but GNSS and DEBUG cannot. The user must set these two serial port
numbers.

Case I: The GNSS/DEBUG of OpenRTK330 EVK is the USER serial port number plus 1 and 2 respectively. Just
configure the “useDefaultUart” field to 1, and the “uart” field does not work at this time.
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v i@ &0 (COM #1 LPT)
& USE Serial Port (COM10)
f USB Serial Port (COM11)
& USE Serial Port (COM12)
f USB Serial Port (COMY)

Case 2: If the user needs to specify the GNSS/DEBUG serial port number, or does not use the GNSS/DEBUG serial
port (the user has not made a hardware connection), the “useDefaultUart” needs to be configured to 0, and the “vart”
field is valid at this time, the GNSS/DEBUG When “enable” is 1, it means to use this serial port. When not in use,
configure it to 0. “Value” should be the serial port name of the serial port in the system. For example: under windos,
open the device manager, as shown in Figure above, find the connected GNSS and DEBUG serial numbers are COM10
and COM11 respectively, the configuration should be as follows:

"uart": [

{
"name": "GNSS",
"value": "comlO",
"enable": 1

}o

{
"name": "DEBUG",
"value": "comll",
"enable": 1

]I

2) Setting paracmeters

When starting the python driver with the “-s” suffix, the “userParameters” parameters can be automatically configured
to the OpenRTK device and saved after power off. Find “userParameters” as shown in Figure 2, and configure fields
for user parameters. All configurable fields are in “userConfiguration”, except for “Data CRC” and “Data Size” whose
paramld is O or 1 are not configurable, the others can be added to “userParameters”. Among them, “paramld” and
“value” are mandatory fields, the value of paramld must be consistent with that in “userConfiguration”, and the type
of value must be consistent with “type”.

For example: to configure Ethernet and NTRIP services, the following configuration is required, where the Ethnet
mode value is 1 to use static IP mode, and the value is 0 to use DHCP mode.

"userParameters": [
{
"paramId": 13,
"name": "Ethnet mode",
"value": 1

"paramId": 14,
"name": "STATIC IP",
"value": "192.168.137.110"

"paramId": 15,
"name": "NETMASK",
"value": "255.255.255.0"

"paramId": 16,

(continues on next page)
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(continued from previous page)

"name": "GATEWAY",
"value": "192.168.137.1"

"paramId": 18,
llname": "IP“’
"value": "203.107.45.154"

"paramId": 19,
"name": "PORT",
"value": 8001

"paramId": 20,
"name": "MOUNT POINT",
"value": " RTCM32_GGB"

"paramId": 21,
"name": "USER NAME",
"value": "username"

"paramId": 22,
"name": "PASSWORD",
"value": "password"

6.3.2 ST GNSS UART1

e Pin: ST_UART1_TX#59), ST_UART1_RX(#60)
¢ Default configuration

* Baud tare: 460800 b/s

* Stop bit: 1

* Data bits: 8§

* Check Digit: None

* Data formation: RTCM3 format

* Main function: Send raw data of GNSS receiver satellite signal

6.3.3 DEBUG UART1

e Pin: DEBUG_TX(#51), DEBUG_RX(#52)
* Default configuration

 Baud tare: 460800 b/s

 Stop bit: 1

6.3. Communication Ports and Operation
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* Data bits: 8

* Check Digit: None

* Data formation: ASSIC format, “P1” packet format

* Main function:

* Send “p1” packet data (more detailed than user serial port data), not sending by default

* Get user parameters (only basic parameters are included, user serial port can get all parameters)

 Control “p1” packet data on or off

6.3.4 ST UART PROG

e Pin: ST_UART_PROG_TX(#49), ST_UART1_PROG_RX(#50)
¢ Default configuration

* Baud tare: 460800 b/s

* Stop bit: 1

* Data bits: 8§

* Check Digit: None

¢ Main function: ST GNSS chip firmware download interface (SDK download port)

6.3.5 BT UART

¢ Pin: BT_UART2_RX(#35), BT_UART2_TX(#36)

¢ Default configuration

* Baud tare: 460800 b/s

* Stop bit: 1

* Data bits: 8

* Check Digit: None

¢ Main function

* Receive RTCM3 data from GNSS base station

* Send module position data in NMEA GPGGA format

6.3.6 SPI Pin Definition

e Pin: USER_MOSI(#29), USER_SCK(#30), USER_NSS(#31), USER_MISO(#32)
¢ Default configuration

* Frame format: Motorola

* Data length: 8 bits

* First bit: 1

CPOL: High

6.3. Communication Ports and Operation
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CPHA: 2Edge
Main function

Send “p1” data, “p1” packet format (see 4.3 for details)

6.3.7 CAN Pin Definition

Pin: CAN_RX(#53), CAN_TX(#54)

Default configuration

ECU address: 128 (automatically match, add 1 to this address, maximum 247)
Baud rate: 250K

Data format: can communication protocol, which can be divided into the following 3 categories according to
functions:

Setting parameters: the user sends a setting parameter command, the module does not return

Get parameters: the user sends a get parameter command, the content of the command is the PF number and PS
number of the data required by the user, and the module returns the corresponding data frame

Data packet: The module continuously sends data packets according to the data type and frequency configured
by the user

Main function
Support SAE J1939 protocol
Configure CAN interface parameters

Send user data packet

6.3.8 RMII Pin Definition

Pin: ETH_RESET(#8), RMIL_TXDO(#9), RMIL_TXDI(#10), RMIL_TX_EN(#11), VDD_CORE(#12),
VIN(#13), RMIL_RXD1(#14),

ETH_MDC(#15),RMII_RXDO(#16),RMII_REF_CLK(#17),ETH_MDIO(#18),RMII_CRS_DV(#19)

Default configuration

DHCP mode

Hostname: openrtk, you can access the Web Interface through http://openrtk in the LAN
Main function

Support static IP mode and DHCP mode

Access to Web Interface configuration parameters (including Ethernet, NTRIP, etc.)

Establish NTRIP CLIENT to pull base rtcm3 data
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The OpenRTK330LI EVK

Contents

e 1. Introduction

* 2. OpenRTK330 EVB

7.1 1. Introduction

The OpenRTK evaluation kit (EVK) is a hardware platform to evaluate the OpenRTK330 GNSS RTK/INS
integrated positioning system and develop various applications based on this platform. Supported by
the online Aceinna Navigation Studio the kit provides easy access to the features of OpenRTK330 and

explains how to integrate the device in a custom design. The OpenRTK EVK is shown below after
unpacking.
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where
e 1: ST-Link debugger
e 2: Multi-Constellation Multi-frequency GNSS antenna
* 3: Micro-USB cable
* 4: OpenRTK330 Evaluation Board (EVB) with metal flat mounting board
* 5: 12-V DC adapter with 5.5 x 2.1 mm power jack

7.2 2. OpenRTK330 EVB

An OpenRTK330 Evaluation board is shown below in detail

where

1: OpenRTK330 GNSS/IMU integrated module
2: GNSS antenna SMA interface

3: Espressif ESP32 bluetooth module

4: SWD/JTAG connector, 20-pin

5: Extension connector with 6-pin interfaces from left to right
- GND

— Not Connected

7.2. 2. OpenRTK330 EVB
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7.2. 2. OpenRTK330 EVB
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e 8
« O
* 10.

e 11.
e 12.

Not Connected

Connects to pin #56 “USER_UART2_TX” of the OpenRTK330 module
Connects to pin #55 “USER_UART2_RX” of the OpenRTK330 module

1PPS outlet

. Extension connector with 6-pin SPI interfaces from left to right

Connects to pin #29 “USER_MOSI” of the OpenRTK330 module
Connects to pin #30 “USER_SCK” of the OpenRTK330 module
Connects to pin #31 “USER_NSS” of the OpenRTK330 module
Connects to pin #32 “USER_MISO” of the OpenRTK330 module
Connects to pin #39 “USER_DRDY” of the OpenRTK330 module
GND

. Boot mode switch with two positions (A and B)

. RJ45 jack for Ethernet interface

Micro-USB port
CAN interface
Power jack for 12-v adapter

EVB working status LEDs from left to right

— Yellow: ST GNSS chipset is powered on and working properly

— Red: valid GNSS base station data receiving

— Green: valid GNSS signal receiving

7.2.1 EVB Mechanical Drawing

The following mechanical drawing shows the EVB dimension (in mm) and the position of IMU navigation center.
The IMU navigation center is fixed to the left-bottom corner of the OpenRTK330LI module on the EVB. User is
recommended to measure the level arm from the GNSS antenna phase center to the IMU Navigation center as accurate

as possible.

7.2. 2. OpenRTK330 EVB
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O

76.20

33,98

fib A0

The following mechnical drawing shows the dimension (in mm) of the mounting plate for the OpenRTK330LI EVB:

7.2. 2. OpenRTK330 EVB 70
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7.2.2 EVB Schematic
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CHAPTER 8

ACEINNA protocol data format definition

Start 1 | Start

Frame type | Frame type
1 2 1

Data length

Data
tent

con-

Check Check

Description:

« Start: Each frame of data starts with this, 2 bytes: 0x55 0x55.

* Frame type: 2 bytes, high byte first.

¢ Data length: 1 byte, refers to the byte length of the data content.

 Data content: maximum 255 bytes.

* Check: crc16 check, 2 bytes, low byte first, bytes from the beginning of the “Frame type” to the end of the “Data
content” are included in the check calculation, and the check algorithm C code is as follows:

uintl6_t CalculateCRC

{

uintl6_t crc =

for (int 1i=0; i <
crc *= buf[i]
for (int 3=0;
if (crc &
crc =
}
else {
crc =
}
}
}
return ((crc << 8

(uint8_t *buf, uintl6_t

0x1DOF;

length;
<< 85
j<8; Jj++) A
0x8000) {
(crc << 1)

i+4+) {

~ 0x1021;

crc << 1;

) & OxFEFO00) | ((crc >> 8)

length)

& OxFF);
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USER UART Data Packet

9.1 Get the hardware version number

9.2 Get the software version humber

9.3 Get user parameters

Frame type
Description
Request frame Start
0x55 0x55
Return frame Start
0x55 0x55
Offset Variable type
0 uintl6
2 uint16
4 char * 2
6 uint16
8 float
12 float
16 float
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20 float
24 float
28 float
32 float
36 float
40 float
44 uint8
45 uint8 * 4
49 uint8 * 4
53 uint8 * 4
57 uint8 * 6
63 char * 23
86 uint16
88 char * 20
108 char * 16
124 char * 24
148 uint16
150 uint16
152 uint16
154 uintl6
156 uint16
158 uint16
9.4 Set user parameters
9.5 Save user parameters
Frame type “sC”
Description Save user parameters
Request frame | Start Frame type | Datalength | Data comment | Check
0x550x55 | 0x730x43 | O None CRC_L CRC_H
Return frame Start Frame type | Datalength | Data content Check
0x55 0x55 0x73 0x43 0 None CRC_L CRC_H
If saving is successful, return as it is; if saving fails, return NAK frame
9.6 Failed frame
Frame type 0x15 0x15
Description NAK frame
Request frame | Start Frame type | Data length | Data comment Check
0x550x55 | 0x150x15 | 2 Failed frame type | CRC_L CRC_H

9.4. Set user parameters
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9.7 IMU raw data packet

Frame type “s1”

Description IMU raw data

Data Frame Start Frame Data length Data com- | Check
type ment

0x55 0x55 0x73 36 see below CRC_L

0x31 CRC_H

Data content:

Off- | Variable type | Name Unit | Description

set

0 uint32 week GPS week, seconds within GPS week: GPS

4 double timeOfWeek S time

12 float * 3 accel_g[3] m/s*2| accelerometer(x,y,z)

24 float * 3 rate_dps[3] deg/s | gyroscope (X,y,z)

9.8 Combined solution PVA packet

Frame type
Description
Data Frame
0x55 0x55
Offset Variable type
0 uint32
4 double
12 uint32
16 double
24 double
32 double
40 uint32
44 float
48 float
52 uint32
56 uint32
60 uint32
64 float
68 float
72 float
76 float
80 float
84 float
88 float
92 float
9.7. IMU raw data packet 83
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96 float
100 float
104 float
108 float
112 float
116 float
120 float

9.9 Satellite information for positioning solution

Frame type “sK”

Description | Satellite information

Data Frame Start Frame | Data length Data comment | Check

type
0x55 0x55 0x73 21%n see below CRC_L
0x4B CRC_H

Data content: a frame of data contains multiple satellite information n

Off- | Variable Name Unit | Description

set type

0+n*2] double timeOfWeek S GPS week, seconds within GPS week: accurate to
milliseconds within a week

8+n*2[ uint8 satelliteld atellite number

9+n*2]| uint8 systemld system number: 0: GPS 1: GLONASS 2: Galileo 3:
QZSS 4: BeiDou 5: SBAS

10+n*2 luint8 antennald antenna number: 0: Main antenna 1: Secondary an-
tenna

114n*2 luint8 11cn0 S/N ratio 1: L1

12+n*2 luint8 12cn0 S/N ratio 2: L2 /L5

13+n*2 Hfloat azimuth deg | azimuth

17+n*2 float elevation m height

9.9. Satellite information for positioning solution
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DEBUG UART Data Packet

10.1 Protocol packet format

9 LEINT3

Debug uvart port data package (P1 package) includes four types of data: “imu”, “gnss”, “vel” and “ins”. Each piece of
data contains three parts: packet header, content and check code.

packet header
Offset | Variable type | Name Description
0 uint8 syncl sync 1: OxAA
1 uint8 sync2 sync 2: 0x44
2 uint8 sync3 sync 3: 0x12
3 uint8 header_length Length of packet header: 0x1C
4 uint16 message_id data id: 268-“imu” 42-“gnss” 99-“vel” 507-“ins”
6 uint8 message_type N/A
7 uint8 port_address N/A
8 uint16 message_length | Data length: not including header and check code
10 uintl6 sequence N/A
12 uint8 idle N/A
13 uint8 time_status N/A
14 uint16 gps_week GPS week
16 uint32 gps_millisecs GPS seconds within a week: unit: ms
20 uint32 status N/A
24 uint16 Reserved N/A
26 uint16 version N/A
Check code:

#define CRC32_POLYNOMIAL 0OxEDB88320L

static unsigned long CRC32Value (int 1)

{

(continues on next page)
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(continued from previous page)

int j;

unsigned long ulCRC;
ulCRC = 1;

for (j 8; 3 > 0; 3—)

{
if (ulCRC & 1)
ulCRC = (ulCRC >> 1)
else
ulCRC >>= 1;
}
return ulCRC;

}

~ CRC32_POLYNOMIAL;

unsigned long CalculateBlockCRC32 (unsigned long ulCount,
unsigned char xucBuffer)

unsigned long ulTempl, ulTemp?2;
unsigned long ulCRC = 0;

while (ulCount—— != 0)
{
ulTempl = (ulCRC >> 8) & Ox00FFFFFFL;
ulTemp2 = CRC32Value (((int)ulCRC ~ xucBuffer++) & O0xff);
ulCRC = ulTempl ~ ulTemp2;
}
return (ulCRC);
}
10.2 Original IMU packet
“imu”
Off- Variable type Name Description
set
0 OpenRTKPacket- header header
Header
28 uint32 gps_week GPS week
32 double gps_millisecs GPS seconds within a week (ms)
40 uint32 imuStatus N/A
44 float z_acceleration Accelerometer data on z-axis, y-axis, X-axis
48 float y_acceleration (2)
52 float Xx_acceleration
56 float z_gyro_rate Gyroscope data on z-axis, y-axis, X-axis
60 float y_gyro_rate_neg | (rad/s)
64 float X_gyro_rate
68 int8 * 4 crc[4] check code

10.3 GNSS position solution

10.2. Original IMU packet

86




OpenRTK Documentation

“gnss”
Off- | Variable type | Name Description
set
0 OpenRTK- header header
PacketHeader
28 uint32 solution_status N/A
32 | uint32 position_type Positioning mode: 0: Invalid 1: Single point solution 4:
Fixed solution 5: Floating point solution
36 | double latitude longitude (deg)
44 | double longitude Latitude (deg)
52 double height Altitude (m)
60 | float undulation N/A
64 | uint32 datum_id Geodetic datum coordinate system
68 | float longi- Longitude standard deviation
tude_standard_deviation
72 float lati- Latitude standard deviation
tude_standard_deviation
76 float height_standard_devjiiahieight standard deviation
80 int8 * 4 base_station_id[4] | N/A
84 float differential _age N/A
88 float solution_age
92 | uint8 num- The number of satellites used in the positioning solution
ber_of_satellites
93 uint8 num- N/A
ber_of_satellites_in_|solution
94 uint8 num_gps_plus_glonasN/IA
95 uint8 num_gps_plus_glonasN/&
96 | uint8 reserved N/A
97 uint8 ex- N/A
tended_solution_status
98 uint8 reserved2 N/A
99 | uint8 sig- N/A
nals_used_mask
100 | int8 * 4 crcl4] check code
10.4 GNSS velocity solution
“Vel”
Offset | Variable type Name Description
0 OpenRTKPacketHeader | header header
28 uint32 solution_status N/A
32 uint32 position_type N/A
36 float latency N/A
40 float age N/A
44 double horizontal_speed Horizontal speed (m/s)
52 double track_over_ground | Ground speed (m/s)
60 double vertical_speed Vertical speed (m/s)
68 float reserved N/A
72 int8 * 4 crcl4] check code

10.4. GNSS velocity solution
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10.5 INS position, velocity and attitude solution

(131 99

ins
Off- | Vari- Name| Description
set | able
type
0 Open- header header
RTK-
Packet-
Header
28 | uint32 gps_weékPS week
32 | double | gps_miliREseconds within a week (ms)
40 double lati- | Latitude (deg)
tude
48 | double | lon- | Longitude (deg)
gi-
tude
56 | double | height| Height (m)
64 double north_|vélekityty (north) (m/s)
72 double east_vel¥Welgeity (East) (m/s)
80 | double | up_velo¥locity (up) (m/s)
88 | double | roll | Roll angle (deg)
96 | double | pitch | Pitch angle (deg)
104 | double | az- Yaw angle (deg)
imuth
112 | int32 sta- Combined solution status: 0: invalid 1: INS alignment ongoing 2: INS so-
tus lution is unreliable 3: INS solution is good 4 :INS free(no GNSS update) 5:
Estimating installation angle 6: Completed estima installation angle estima-
tion
116 | int8 *4 | crc[4]| check code

10.5. INS position, velocity and attitude solution
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Port command

11.1 Get module configuration information

Command: get configuration\r\n

Return: string in json format

{

"openrtk configuration":

"Product Name":
"Product PN":
"Product SN":
"Version":
"userPacketType":
"userPacketRate":
"leverArmBx":
"leverArmBy":
"leverArmBz":
"pointOfInterestBx":
"pointOfInterestBy":
"pointOfInterestBz":
"rotationRbvx":
"rotationRbvy":
"rotationRbvz":

nn

4
nn

I4

" n’

ngln ,
100,
0.0,

’

4

O O O O O
~ 0~ 0~

~ 0~

O O O O O o o o

At the same time, the module will close the P1 packet output of the DEBUG port.

11.2 Enable P1 packet output

Command: log debug on\r\n
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Return: N/A, the module will directly output P1 packet data after a delay of 1 second.

11.2. Enable P1 packet output
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CAN Interface Data Protocol

12.1 CAN port settings

 Save parameters

Frame type Save parameters

Description Save user parameters, no loss after power failure

Set frame PF ps PGN Data content length
255 81 65361 3

Data content:

Byte | Description Value

0 Frame type 0: Request frame 1: Reply frame

1 Destination address

2 Reply frame is valid 0: Save failed 1: Save successfully

» Set CAN packet type

Frame Set CAN data packet type
type
Description| Set the type of CAN data sent cyclically
Setframe | PF | PS | PGN Data content length
255 | 86 65366 3
Data content:
Byte| Description Value
0 destination ad-
dress
1 Data packet type 0x01-accelerometer 0x02-Gyroscope 0x04-latitude and longitude 0x08-
(low byte) attitude Note: The package can be sent together, such as 0x03, both ac-
2 Packet type (high | celerometer and gyroscope
byte)

» Set CAN data frequency
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Frame type | Set CAN data frequency

Description | Set the frequency of CAN data sent cyclically

Set frame PF PS PGN Data content length
255 85 65365 2

Data content:

Byte | Description Value

0 destination address

1 Data frequency 0-Quiet Mode 1-100(default) 2-50 4-25 5-20 10(0x0a)-10

20(0x14)-5 25(0x19)-4 50(0x32)-2

12.2 Get parameters through CAN port

Frame type Get parameters
Description Get specified parameters
Get frame PF PS PGN Data content length
234 255 60159 3
Data content:
Byte | Description Value
0 N/A
1 Parameter PF PF and PS of specific parameters, see below 2 parameter PS
2 Parameter PS

¢ Get the software version number

Frame type Get software version number

Description Get specified parameters

Get frame PF PS PGN Data content length
254 218 65242

Data content:

Byte | Description Value

0 Major Version Number

1 Minor Version Number

2 Patch Number

3 Stage Number

4 Build Number

* Get ECUID

12.2. Get parameters through CAN port
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Frame type | Get ECU ID
Descrip- Get specified parameters
tion
Get frame | PF PS PGN Data content length
253 197 64965 8
Data content:
Bits Description Value
bits 0 Arbitrary Address Arbitrary Address
bits 1:3 Industry Group Industry Group
bits 4:7 Vehicle System Instance Vehicle System Instance
bits 8:14 System Bits System Bits Vehicle system domain
bits 15 Reserved Reserved Reserved
bits 16:23 Function Bits Function Bits Function domain
bits 24:28 Function Instance Function Instance
bits 29:31 ECU Bits ECU Bits ECU instance domain
bits 32:42 Manufacturer code Manufacturer code Manufacturer code field
bits 43:63 ID bits ID bits number
* Get CAN packet type
Frame type Get CAN data packet type
Description
Get frame PF PS PGN | Data content length
225 86 65366 | 3
Data content:
Byte | Description Value
0 destination address
1 Packet type (low byte)
2 Packet type (high byte)
* Get CAN data frequency
Frame type Get CAN data frequency
Description
Get frame PF PS PGN | Data content length
255 85 65365 | 2
Data content:
Byte | Description Value
0 destination address
1 Data frequency

 Latitude and longitude position

Frame type Latitude and longitude position

Description

Data frame PF PS PGN Data content length
254 243 65267 8

Data content:

Byte | Description Value

0:3 Latitude 0.0000001 deg/bit

4:7 Longitude 0.0000001 deg/bit

e Attitude
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Frame type Attitude

Description

Data frame PF | PS | PGN Data content length
241 | 25 127257 | 8

Data content:

Byte | Description Value

0 SID

1:2 yaw angle 0.0001 rad/bit

3:4 pitch angle 0.0001 rad/bit

5:6 roll angle 0.0001 rad/bit

7 Latitude

¢ Accelerometer data

Frame type Accelerometer data
Description
Data frame PF PS PGN | Data content length
240 45 61485 | 8
Data content:
Byte | Description Value
0:1 Accelerometer x axis 0.01 m/s**2/bit -320 m/s**2
2:3 Accelerometer y axis 0.01 m/s**2/bit -320 m/s**2
4:5 Accelerometer z axis 0.01 m/s**2/bit -320 m/s**2
6:7 reserved
* Gyroscope data
Frame type Gyroscope data
Description
Data frame PF PS PGN Data content length
240 42 61482 | 8
Data content:
Byte | Description Value
0:1 gyroscope x axis 1/128 deg/second/bit -250 deg
2:3 gyroscope y axis 1/128 deg/second/bit -250 deg
4:5 gyroscope z axis 1/128 deg/second/bit -250 deg
6:7 reserved

12.2. Get parameters through CAN port
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NMEA

$GNGGA

Format: $GNGGA <1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9> M ,<10>M,<  11><12>*xx<CR><LF> E.g:
$GNGGA,072446.00,3130.5226316,N,12024.0937010,E,4,27,0.5,31.924,M,0.000,M,2.0,*44 Field explanation:

* <0> $GNGGA

¢ <1> UTC time, the format is hhmmss.sss

e <2> Latitude, the format is ddmm.mmmmmmm

¢ <3> Latitude hemisphere, N or S (north latitude or south latitude)

¢ <4> Longitude, the format is dddmm.mmmmmmm

* <5> Longitude hemisphere, E or W (east longitude or west longitude)

* <6> GNSS positioning status: 0 not positioned, 1 single point positioning, 2 differential GPS fixed solution, 4
fixed solution, 5 floating point solution

* <7> Number of satellites used

¢ <8> HDOP level precision factor

* <9> Altitude

* <10> The height of the earth ellipsoid relative to the geoid
¢ <11> Differential time

* <12> Differential reference base station label

» * Statement end marker

¢ xx XOR check value of all bytes starting from $ to *

¢ <CR> Carriage return, end tag

* <LF> line feed, end tag
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$GNRMC

Format: $GNRMC <1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,< 12>*xx<CR><LF> E.g: $GN-
RMC,072446.00,A,3130.5226316,N,12024.0937010,E,0.01,0.00,040620,0.0,E,D*3D Field explanation:

* <0> $GNRMC

¢ <1> UTC time, the format is hhmmss.sss

* <2> Positioning status, A=effective positioning, V=invalid positioning
¢ <3> Latitude, the format is ddmm.mmmmmmm

* <4> Latitude hemisphere, N or S (north latitude or south latitude)

* <5> Longitude, the format is dddmm.mmmmmmm

* <6> Longitude hemisphere, E or W (east longitude or west longitude)
* <7> Ground speed

* <8> Ground heading (take true north as the reference datum)

* <9> UTC date, the format is ddmmyy (day, month, year)

* <10> Magnetic declination (000.0~180.0 degrees)

¢ <11> Magnetic declination direction, E (east) or W (west)

* <12> Mode indication (A=autonomous positioning, D=differential, E=estimation, N=invalid data)
 * Statement end marker

* XX XOR check value of all bytes starting from $ to *

* <CR> Carriage return, end tag

e <LF> line feed, end tag

$GNGSA
format: $GNGSA <1>,<2>,<3>,<3>,,,.,.<3>,<3>,<3>,<4> <5>,<6>,<7> #xx<CR><LF> E.g:
$GNGSA,A,3,03,06,09,17,19,23,28,...,,3.0,1.5,2.6,1%25 $GNGSA,A,3,65,66,67,81,82,88,...,,,2.4,1.3,2.1,2*%36

$GNGSA,A,3,02,05,09,15,27,,,.,,,10.8,2.7,10.4,3*3A $GNGSA,A,3,01,02,07,08,10,13,27,28,32,33,37,,2.1,1.0,1.9,5%33
Field explanation:

¢ <1> Mode: M=Manual, A=Auto

* <2> Positioning type: 1=not positioned, 2=two-dimensional positioning, 3=three-dimensional positioning
¢ <3> PRN code (Pseudo Random Noise Code), channels 1 to 12, up to 12

* <4> PDOP position precision factor

¢ <5> HDOP level precision factor

* <6> VDOP vertical precision factor

e <7> GNSS system ID: 1(GPS), 2(GLONASS), 3(GALILEO), 5(BEIDOU)

¢ * Statement end marker

* xx XOR check value of all bytes starting from $ to *

¢ <CR> Carriage return, end tag

* <LF> line feed, end tag
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Overview

14.1 What is RTKIib

RTKLIB is an open source program package for standard and precise positioning with GNSS (global navigation
satellite system). It supports standard and precise positioning algorithms with GPS, GLONASS, Galileo, QZSS,
BeiDou and SBAS.

14.2 RTKIib tools supporting Aceinna Format

RTKIib tools supporting Aceinna Format is s special version of RTKlib which supports aceinna data format to display
data, decode data, save data, and also plotting and RTK processing.

RTKLIB_with Aceinna format binary version: https://github.com/Aceinna/rtklib_bin_aceinna

RTKLIB_with Aceinna format_source version: https://github.com/Aceinna/rtklib_aceinna

14.3 Aceinna data format

Aceinna-user and aceinna-raw are two data formats exported from Openrtk330LI; They are output from serial port 1
and serial port 3 of Openrtk330LI; Aceinna-user data include imu raw data, rtk and ins solution; Aceinna-raw includes
rover, base RTCM data and imu raw data.

14.3.1 Aceinna-User Format

Data format definition

| Start 1 [ Start2 | Frame type 1 | Frame type 2 | Datalength 1 | Data content | Check 1 | Check 2 |

Description
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Start: Each frame of data starts with this, 2 bytes: 0x55 0x55.
* Frame type: 2 bytes, high byte first.
» Data length: 1 byte, refers to the byte length of the data content.

 Data content: maximum 255 bytes.

Check: crc16 check, 2 bytes, low byte first, bytes from the beginning of the “Frame type” to the end of the “Data
content” are included in the check calculation, and the check algorithm C code is as follows:

uintl6_t CalculateCRC (uint8_t xbuf, uintlé6_t length)

{
uintl6_t crc = 0x1DOF;

for (int i=0; i < length; 1i++) {
crc *= buf[i] << 8;
for (int 3=0; 3j<8; Jj++) {
if (crc & 0x8000) {

crc (crc << 1) »~ 0x1021;
}
else {
crc = crc << 1;
}
}
}
return ((crc << 8 ) & OxFFO00) | ((crc >> 8) & OxFF);

}

Frame types

Aceinna-user has five types of data, namely “S1”, “G1”, “I1”, “O1” and “Y1”’; For the specific structure of each type of
format, please refer to the openrtk documentation https://openrtk.readthedocs.io/en/latest/communication_port/User_
uart.html#imu-raw-data-packet

14.3.2 Aceinna-raw Format

Aceianna-raw is composed of four format types of $§GPGGA$SGPIMU$GPROV$GPREF;
$GPGGA

$GPGGA is the standard NMEA GGA format.

$GPIMU

$GPIMU is the IMU information in NMEA format.

] $GPIMU \ time of week \ accel-x | accel-y | accel-z | gyro-x | gyro-y | gyro-z

$GPROV
$GPROV contains the RTCM package from Rover.

| SGPROV | time of week | left length | RTCM bin | |

$GPREF
$GPREF contains the RTCM package from Base.
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| SGPRRF | time of week | left length | RTCM bin | |
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Instructions

15.1 Use strsvr to decode aceinna-user data

Use strsvr to decode aceinna-user data format. Decode aceinna format data and display information in monitor dialog
and save it in files.

15.1.1 Set input stream parameter

Select serial for (0) input. Click “opt” button to open the Serial Options dialog.

STRSVR ver.demo5 b33c
Stream Type Opt Cmd Conv Bytes Bps
(0) Input  |Serial [ - 0 0
(1) Output |File | v 0 0
P Start £ Options... Exit

Select the first serial port in the serial Options dialog.
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STRSVR ver.demo5 b33«
2020/11/13 07:23:11 GPST Connect Time:  0d 00:00:00
S'i Serial Options » f Bos
"y 0
s 0
w
(9{ OloutputReceived Stream to TCPPort | |
| oK Cancel
o ;|
P Start £ Options... Exit

Bitrate is selected as 460800.

STRSVR ver.demob b33¢
2020/11/13 07:23:49 GPST Connect Time: 0d 00:00:00
5iSermI Options * r Bps
1 poet COM7 v Parity None v 0
1 Bitrate (bps) Stop Bits 1bit s 0
(2)( Bvte Sze Flow Control None A
(39{ [Joutputre b TCP Port

P Start

15.1.2 Set output files path

Select the path to save the file. For example: C:/Users/zhangchen/Desktop/rtklog/.

'\- ;!\I'..'. -‘. ver.demos i 3 i
2020/11/13 07:25:46 GPST Connect Time: 0d 00:00:00

| Stream Type Opt Cmd Conv Bytes Bps
File Options X |
Output File Path

| \sers\zhangchen\Desktop'y tdog\test-%-%m-%d_%h-%M-%s.dat] || ..

[OTmeTag Swapintv|  v|H 2 ox Cancel

P Start £ Options... Exit

15.1.3 Show the data in monitor dialog and save file

Click the small square button to open Input Stream Monitor dialog.
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Bytes Bps
0 0
0 0
2) Outpu e
3) Outpu -
» Start £} Options... Exit
Select the aceinna-user format.
i £ Input Stream Monitor *
Aceinna-user | X ® | Close
Streams ~ ~
HEX
ASCIT
RTCM 2
RTCM 3
NovAtel OEMS.
ComNav
u-blox
Swift Navigation
SkyTrag
GW10
Javad
NVS BINR
BINEX
[Trimble RT17
CMR/CMR +
[TERSUS
| Aceinna-user R
Click “start” button to start receiving data.
STRSVR ver.demoS b33c
2020/11/16 09:08:24 GPST Connect Time:  0d 00:00:00
Stream Type Opt Cmd Conv Bytes Bps
S o e ] oo
5 o AL o o
o E
‘ > Start ‘ £ Options... H Exit |

Strsvr is running.
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STRSVR ver.demo5 b33c

2020/11/17 01:40:27 GPST Connect Time: 0d 00:01:34
Stream Type Opt Cmd Conv Bytes Bps
M (0)Input | Serial (] ]| oo 453,784 38,538
M (1) Output File (] o |- ... 453,784 38,309
v
A
o COM7 4
[ B Stop ; Options... Exit

The data decoding information is showed in monitor dialog.

#* Input Stream Monitor X

Acemnauser V| X w4

32.720 ~
0.000
11.€55
0.000

2132,
2132,
2132,
2132,
2132,
2132,

82.470
3€.4€4
$3.454
75.€28
40.971
17.56€5
s5.428
€8.717
€4.847

45.87€
52.473
-9.7130279541, 0.08€3125€22, -0.55€71
-5.7130279541, 0.0802078173, -0.
-9.7130279541, 0.0800845027,
.-l -9.7114448547, 0.07401€332€, -0.58103
-1.171596€4€3, -9.7098€27090, 0.0€80714771,
-1.172394€333, 708278€5€0, 0.0741575235,
, -1.173152739s, 708278€5€0, 0.0802443€98,
, -1.174785€140, -5.7090682983, 0.074299529
o.
0.
0.

S, -1.174785€140, -5.7106504440, 0€3354€83¢,
0123204570, -1.1739875078, 0€9354€88¢6, -0.54964
01152100€0, -1.1731892824, -9.7114448547, 0€8354€88€, -0.5562¢

v

2132,178872

The file is saved in the previous output path.

» rtklog

~ test-2020-11-17_01-38-52.dat

~ test-2020-11-17_01-38-52.dat.nmea
B3 test-2020-11-17_01-38-52.dat g1.csv
B test-2020-11-17 01-38-52.dat s1.csv
B3 test-2020-11-17 01-38-52.dat y1.csv

15.2 Use RTKLIBNAVI to decode aceinna-user data

Aceinna-raw data is the result outputfrom OpenRTK330. Using rtklibnavi to connect the first serial port of openrtk330,
the RTK processing result data can be recognized These data can be displayed by SNR plot, sky map and GND Trk.

15.2. Use RTKLIBNAVI to decode aceinna-user data
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15.2.1 Set input stream parameter

Click the ‘T’ button to open Input Streams dialog.

RTKNAVI ver.demo5 b33c

Check (1) Rover in the Input Streams dialog.

] Input Streams X )‘
oo ream Type Opt Cmd Format Opt
[J (1) Rover NTRIP Clent .. .. RTCM3 |
D (2) Base Station NTRIP Client g . | RTCM 3
[1(3) Correction NTRIP Client . RTCM 3
1 oFfF w|0.000000000 0.000000000 0.000
ese : 10
Time |x1 +/0 s |32bit oK Cancel

Select “serial” in the type option.

l week 1042 518400.0 s GPSr‘ I NO0-{-00000 0[ L J
£ XY /ZECEF ~ || Rover:Base SNR (dBHz) Gnd Trk r -
o #
20| ©
Solution: O
X: 0.000 m
Y: 0.000 m
z:
X:0
50 am
<m >l
o
» start ® Mark... ‘ @ plot 2% Options... Exit

15.2. Use RTKLIBNAVI to decode aceinna-user data
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] Input Streams X
Input Stream Opt Cmd Format Opt +
(1) Rover RTCM 3 ~
[ (2) Base Station RTCM 3
[ (3) Correction RTCM 3
OFF 000000000 ||0.000
d Baseline |10
Time x1 +0 s |32bit oK Cancel
Click “opt” button to open the Serial Options dialog.
1 Input Streams X
Input Stream Type Cmd Format Opt +
M (1) Rover Serial v RTCM 3 -
D (2) Base Station NTRIP Client we | o | RTCM 3
[ (3) Correction NTRIP Client v || - ||RTCM 3
OFF 0.000000000 ||0.000000000 ||0.000
eset Cmd Baseline |10
Time x1 +0 32bit oK Cancel
Select the frist serial port in the serial Options dialog.
Input Streams X ‘
Input Stream Type Opt Cmd Format Opt
(1) Raver | Serial AT [ acei ~
[ (2) g Serial Options X
0@ 9 port Parity None v [‘
ansmi COM7 " )
- Bitrate (bps) COMS Stop Bits 1 bit v
" COM39 |-
Resetd Byte Size CoM10 Flow Control | None v
L, 5 [J]output Received Stream to TCP Port |
OK Cancel
Time |x1 +|0 32bit

Bitrate is selected as 460800.
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p —
4 Input Streams

>< 1
{ Input Stream Type Opt Cmd Format Opt *
| MR > v
mley: Serial Options X
| O®¢ port coMs | Pparity —
| 5T pitrate (bps) (460800 | ftopBits | 1bit v
OFF
1 | Bytesize  |Bbits ~ | Flow Control | None ~
=| [[Joutput Received Stream to TCP Port
-
1 Time |x1 +|0 32bit oK Cancel
Format is selected as Aceinna-raw.
Input Streams x
Input Stream Type Opt Cmd Format Opt
M1 (1) Rover Serial v Aceinna-user v
7) Base Stat NTRIP Client . [NovAtel OEME
[1(2) Base on ien ComNav
[[](3) Correction NTRIP Client . |u-blox
. - Swift Navigatior
- - . Hemisphere
OFF SkyTraq
GW10
e Javad
F NVS BINR
BINEX
Trimble RT17
Septentrio
CMR/CMR +
TERSUS
Aceinna-user
Time |x1 +|0 32bit OK [Aceinnataw ¥
15.2.2 Set output log files path

Select the path to save the file. For example: C:/Users/zhangchen/Desktop/rtklog/.

Click the ‘L’ button to open Log Streams dialog.

RTKNAVI ver.demo5 b33c

» Start

Solution (S): FIX

X: -2751626.943 m
Y: 4697010.657 m
Z:

3312825.285 m

s GPST

<

B> )| 1020 23243132 0405

@ Mark...

15 16 01 04 19 21 27 33 01 02 03 04 05 06 07 09 13 16 21 24 26 3149

@ plot & Options...

Check (6) Rover ,select File type and input the log file paths. Click “OK” button.

15.2. Use RTKLIBNAVI to decode aceinna-user data
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Log Streams X
Lagesiream . Type ~Opt
[~1(6) Rover File v [Joutput Event
[J(7) Base station Serial
[ ) correction Serial !
Tt

lC: \Users\zhangchen\Desktopy thlog\getdata- %%y Yen-%h %M %S, dat

(] Time-Tag Swap Intv H > |

oK

15.2.3 Start to receive data

Click the “start” button to start receiving the data.

RTKNAVI ver.demo5 b33c

‘ week 2132 196074.4 s GPST

Rover SNR (dBHz)
GREC

N [2-ECEF M

Solution (S): FIX O
X: -2751626.943 m
Y: 4697010.657 m

y4 3312825.285 m

! |000-0-00000 o | L
Gnd Trk .
]
el

e

10 20 23 24 31 32 04 05 15 16 01 04 19 21 27 33 01 02 03 04 05 06 07 09 13 16 21 24 26

& Options...

® Mark.. | © 2ot

» Start

When receiving the data, the SNR bar is plotted.

RTKNAVI ver.demo5 b33c
| week2132196749.15 GPST © | WOC-E-00m00 o | L
X /Y [Z-ECEF + || Rover SNR (dBHz) Gnd Trk A
GREC
)
2
Solution (S): FIX m
X: -2751627.544 m
Y: 4697012.043 m @
z: 3312825.523 m
X:0 0 Z: n ‘
. J 10 20 23 25 3204 0509 15 16 01 04 11 12 19 21 27 01 02 03 04 05 0709 13 16 21 24 31.494459732 120.362f
o (1) com7
® Stop @ Mark... @ Plot 4+ Options... Exit

Click the arrow button to switch view (SNR bar, sky map, positioning coordinates, horizontal error scatter, position

error timeseries in north, east and up).

15.2. Use RTKLIBNAVI to decode aceinna-user data
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RTKNAVI ver.demo5 b33c
week 2132 107175.25 GPST W00 o | L
= X/Y[ZECEF M Rover SNR (dBHz) A - Gnd Trk - -
GREC )
50| o
Solution (S): FIX
X: 2751627.542 m 0
Y: 4697012.046 m @
z: 3312825527 m -
20|
50
[ | 710 20 21 23 25 32 04 05 09 15 16 01 04 11 12 19 21 27 01 02 03 04 05 07 09 13 16 21 24 2 31.494459732 120.3628-‘119OSCL|
o (1) com7
» Stop ® Mark... @ Plot 4t Options. Exit
The sky map.
| RTKNAVI ver.demo5 b33c
| week 2132 106767.7 s GPsT 1 WOCEO0E00 o | L
1 X/Y[Z-ECEF || Rover N v |~ |[[endTrk A
e ™~ o
A h
P ° )
E)
Solution (S): FIX / o % %g \
X: 2751627543 m / \
Y: 4697012.049 m W D ﬁ € @
z: 3312825528 m \ g ki) /
: N T4
\ @
\ L&
® pd
- 7 0
__| — - _soem
g #Sat:30/30 5 GDOP: 1.1 ||| 31.494459732 120.362841908—
o (1) coM7 .
W Stop ‘ @ Mark... ‘ @ Plot %t Options... Exit
Both sky map and SNR plot.
RTKNAVI ver.demo5 b33c
| week 213219677055 GPST 1| WO0-m-00000 o | ¢ |
XN [ZECEF v Rover - hd Gnd Trk v v
o
I}
Solution (S): FIX m
X: -2751627.541 m
Y: 4697012.044 m #Sat:30/30 GDOP: 1.1 O
z: 3312825521 m SR
40|
30|
20|
50
|| 1020 2325 3204 05 09 15 16 01 04 11 12 19 21 27 01 02 03 04 05 06 07 09 13 16 2124 26 || 31494459732 120.362841906——
o (1) com7 ?
W Stop @ Mark... ‘ @ Plot 4t Options... Exit

The Gnd Trk.

15.2. Use RTKLIBNAVI to decode aceinna-user data
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RTKNAVI ver.demo5 b33c
week 2132 196789.3 s GPST BOO~m-00 N oL
] ]
2 2
Solution (S): FIX m
X: -2751627.541 m
Y: 4697012.040 m @ @
z: 3312825.525 m
. 50 N
=)| 31 e+ 4 A 494459
o co
W Stop @ Mark... @ Plot £¥ Options.. Exit
Click the “Plot” button to open RTKPLOT.
RTKNAVI ver.demo5 b33c
week 2132 196818.7 s GPST N00+-E~00 M oL
]
2
Solution (S): FIX m
X: -2751627.538 m
Y: 4697012.046 m @ @
z: 3312825523 m
||| 3t 2 >—j<
W Stop @ Mark... | g @ Plot |! £+ Options.. Exit
The RTKPLOT dialog.
1 % RTKNAVI ver.demos b33c : RTKPLOT - o X
file Edit View Windows Help
12 otV V|3 - T o4 s eESE X W0 &
1
i
#
qd
q
1am
;4:[“]2020/11/1706:40:46.14057: 31.494459761°N 120.362842530° 119.2353m Q=1:FIX .

Select the drop-down list to switch views.

15.2. Use RTKLIBNAVI to decode aceinna-user data
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a5
¥4 RTKNAVI ver.demo5 b33c : RTKPLOT

- o
Fle Edit View Windows Help
sESHE X 00w
q
5
]
1
=
'j[ﬁ]zﬂzﬂ/u/nne:«:sa.«cpsr: 31.494459795°N 120.362842606° 119.2305m Q=L:FIX .
The Position views.
ar
4 RTKNAVI ver.demos b33c : RTKPLOT - O
Fle Edit View Windows Help
\*12 Positorl v| AL v| % v W T @ o @ X 00 &
9 $
q %05 Ewm
|
| 0.0 TR
-0.05
005 s m)
0.00 WP ®)
d 005
4 0.05 uD(m
0.00 ;*\‘.:&:ﬁ,,?\@qiu
1
-0.05

’ii [R12020/11/17 06:42:17.80 GPST : E= 0.0008m N= 0.0002m U= 0.0014m Q=1:FIX

06:4¢
2020/11/17 06:39:54 GPST

Click “stop” button to stop receiving data.

RTKNAVI ver.demo5 b33c

week 2132 196964.7 s GPST

Solution (S) FIX m
X: -2751627.545 m
Y: 4697012.050 m

Z: 3312825527 m

£+ Options..

Exit

The file is saved in the previous output path.

15.2. Use RTKLIBNAVI to decode aceinna-user data

111



OpenRTK Documentation

» rtklog

- getdata-20322-063904.dat

- getdata-20322-063904.dat.nmea
B getdata-20322-063904.dat_g1.csv
B getdata-20322-063904.dat s1.csv
B getdata-20322-063904.dat y1.csv

15.3 Use RTKLIBNAVI to decode aceinna-raw data

Aceinna-raw data contains the original data of rover station and base station. Using rtklibnavi to connect the third
serial port of openrtk330, the rover station and the base station information can be read at the same time. These data
can be displayed by SNR plot, sky map, baseline and GND Trk. At the same time, these data can also be used for RTK

processing.
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15.3.1 Set input stream parameter

Click the ‘T’ button to open Input Streams dialog.

RTKNAVI ver.demo5 b33c

Check (1) Rover in the Input Streams dialog.

0.05 GPST

Solution:

X: 0.000 m

Y: 0.000 m

z: 0.000 m
< >

o

» Start @ Mark... @ Plot £ Options...
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] Input Streams

X
Ioput Stream Type Opt Cmd Format Opt +
II:l (1) Rover NTRIP Client RTCM 3
[J(2) Base Station | NTRIP Client . RTCM3
[ (3) Correction NTRIP Client . RTCM 3
OFF 0.000000000 0.000000000 0.000
d Basel 10
Time |x1 +|0 s | 32bit oK Cancel
Select serial in the type option.
1 Input Streams X
Input Stream Opt Cmd Format Opt +
M (1) Rover RTCM 3 ~
[ (2) Base Station RTCM 3
[1(3) Correction RTCM 3
OFF 000000000 0.000
ese Base 10
Time |x1 +/0 32bit oK Cancel

Click *

‘opt” button to open the Serial Options dialog.

] Input Streams

x|

Input Stream Type Qot Cmd Format Opt ¢
(1) Rover Serial RTCM 3 ~
[J(2) Base Staton | NTRIP Client . RTCM3
[1(3) Correction NTRIP Client . RTCM 3
OFF 0.000000000  ||0.000000000 | 0.000
ece d Basel 10
Time |x1 0 32bit oK Cancel

Select the third serial port in the serial Options dialog.
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] Input Streams X %
Input Stream Type Opt Cmd Format Opt *
MR i v ~
mley: Serial Options X
03¢ port Parity None v [”
1 “™ Bitrate (bps) StopBits | 1bit v
OFF
1. | Bytesize Flow Control | None |
1+7 [Joutput Received Stream to TCP Port
oK Cancel
Time |x1 +0 s | 32bit oK Cancel
Bitrate is selected as 460800.
] Input Streams x %
Input Stream Type Opt Cmd Format Opt -
MR i = >
O Serial Options X

G port COM9 | Parity None v [\
2T Bitrate )s} top Bits | 1bit v
i OFF

| ByteSize |8 bits ~ | Flow Control |Nene v

,+5 [[]Output Received Stream to TCP Port

[ o ] one

Time |x1 +10 s | 32bit

oK Cancel
Format is selected as Aceinna-raw.
Input Streams X
Input Stream Type Opt Cmd Format Opt |
M (1) Rover Serial v . | Aceinnataw v
[J(2) Base Station | NTRIP Client i || | RTCM3
[ (3) Correction NTRIP Client wi || e ||RTCM 3
OFF 0.000000000 0.000
Re =110
Time |x1 +10 s | 32bit

|

15.3.2 RTK processing config

Close the Input Streams dialog and click the “options” button to open the options dialog.
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RTKNAVI ver.demo5 b33c

1 >
L8
||| ©
Solution: [
X: 0.000 m
Y: 0.000 m
z: 0.000 m
< > |
o

» Start @ Mark... @ Plot

| E £ Options... ' Exit

In the options dialog, choose the RTK posting mode option as “kinematic” or “static”.

Options

Positioning Mode
Frequendies

Elevation Mask (%) / SNR Mask (dbHz)

Raw Obs weighting Elevation v

Rec Dynamics / Earth Tides Correction on v ||orr <t

Tonosphere Correction Broadcast v |

Troposphere Correction |

Satellite Ephemeris/Clock Broadcast v
satPCV [ |RecPcv [ |Phwu [ |RejEd [JRAIMFDE | |DBCorr

Excuded Satelites (+°RN: Induded) ||

GPs [Glo [Galleo []Qzss []sBAS [ABeiDou [JIRNSS

Cancel #

15.3.3 Start to receive data

Click “start” button to start receiving the data.

RTKNAVI ver.demo5 b33c
GPST I - -
L8
||| ©
Solution: [
X: 0.000 m
Y: 0.000 m
z: 0.000 m
< > |
@ Mark... @ Plot £ Options... Exit

When receiving the data, the SNR map of Rover and base according to the data will appear in GUI, and RTK results

will be displayed.
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week 2132 181473.05  GPST I |WOC-m+00m00 o | v
3 XY [ZECEF ~ || Rover:Base SNR (dBHz) hd ~_||[Gnd Trk SN
oec ||| g
. n e
Solution (S): FIX W
X: -2751626.903 m
Y: 4697010.922 m || 020513151520 752429%0030405 121417 815071318 330102030405060809 12 1316212234 ‘&
z: 3312823.988 m GrEc
s0am
[ 4 121417181907131 1 34 (|| 31494454081 120. 362842684
o (1) coms
" s © Mark... | © ot £t Optins... Ext

Click the arrow button to switch view (SNR bar, sky map, positioning coordinates, horizontal error scatter, position

error timeseries in north, east and up).

RTKNAVI ver.demo5 b33c
week 2132 181547.55  GPST 1 |WO0-#+00m00 o | L
= XVZECEF ~_ | Rover:Base SR (d8riz) E— A R -
ReC ||| g
- - g5
Solution (S): FIX W
X: -2751626.901 m
Y: 4697010.923 m || 020513151820 23242530030 14171819071319 '30330102030405060809 12 1316212234 O
z: 3312823.991 m Grec
Hi m | 140|
0
50 am
= 0! 14171819071319; I 4 (|| 31494454081 120, 362842684
o (1) coms
» stop ® park... © glot 44 Options... Exit
The sky maps.
RTKNAVI ver.demo5 b33c
week 2132 182019.1s  GPST I \[Z*i{]iD: o I L
= XY [ZECEF - || Rover Base - - |fenak T
]
o
o N— N
) / \ .
Solution (S): X | ®£@ @@ \ / g@ 0@ \\\ ¢
X: 2751627198 m | | s @ |/ -y @ \
Y: 4697012288 m |1/ CNE-) £ e o € &
z: 3312823706 m || | D [\ @D /
NCL R LA T X1
\ o) /N @ o)
— —
| #set:2s GDOP: 1.3 #5at:24/38 GooP: 1.4 ||| 31.4
o (1) coms
® Stop @ Mark... @ Plot 1t Options... Exit

The baseline.
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RTKNAVI ver.demo5 b33c
week 2132 18203585 GPST o |WeE-00m00 o [ o
3 XY [Z-ECEF ~ || Baseline A ~ ||/GndTrk y v
®
o
VY .
V4 N
Y
Solution (S): FIX W ."’J‘ ® ‘\‘\ o
X: 2751627.192 m H i
Y: 4697012275 m \[ 0018m N L 2
z 2823.694 m | il
g ¥: 139.2 P:-77.6° || 31.
o
® Stop @ Mark. 4t Options... Exit
The Gnd Trk.
RTKNAVI ver.demos b33c
week 2132 182047.15  GPST 1| WO0-8-00800 o | v
= XN[ZECEF ~ [[end Tk == Gna Tk =
® ®
[ )
Solution (S): ] « «
X: 2751627.194 m
Y: 4697012252 m < (o3
z: 3312823.664 m
0o s0.n
o (1) com9
» stop ® Mark... ‘ @ pot %t Options... Exit
M [ 4l
Click “Plot” button to Open RTKPLOT.
RTKNAVI ver.demo5 b33c
week 2132 181510.0 5 GPST j mOO-#-+-00m00 o | o
5 X)Y[ZECEF v || Ro (dBHz) hd ~_||/GndTrk T
wEc || o
- - Al o
30|
Solution (S): FIX W 20)
X: 2751626.901 m
Y: 4697010924 m || 0205 75242930030405 121317 18 007319 33010203040506080912 1316212234 _ ‘®
z: 3312823.991 m crec
[ 2324293003040512141718 19071319 I 34 (|| 31494454081 12036284
o .
™ Stop © Mark... I 1+ Options... Exit

The RTKPLOT dialog.
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,g RTKNAVI ver.demo5 b33c: RTKPLOT - o X
6 Fle Edit View Windows Help
=|[1)| BTk v/AL v|#H - T @ ¢ % ¢+ E &8 B X %
E
& E
ian z
—
[R]2020/11/17 02:27:15.00 GPST : 31.494454080°N 120.362842695°E 117.3279m Q=1| 31.49445373°N 120.36284323°€ +
:
Select the drop-down list to switch views.
< ¥ RTKNAVI ver.demo5 b33c : RTKPLOT - 0o x #
File Edit Vi s Help
BESEE L v|H - T e+ e SE X0
4
a
1am
—
[R12020/11/17 02:27:34.60 GPST : 31.494454081°N 120,362842696°E 117.3278m Q=1L:FIX .
The Position views.
- &RTKNAVIVerdeMOSbiS(:RTKFLOT - o X W&
File Edit View Windows Help
;+12 Postoi v (AL v 4+ v i T @ o ¢ X 00 &
® 0.05 $
- EAW (m)
3 o000 ety
.68
N-S (m)
0.00 ——
0.05/ yp(m)
0.00 N nd. 4
E
02:25 02:30
[R]2020/11/17 02:28:09.50 GPST : E= 0.0001m N= 0.0010m U= 0.0037m Q= 1:FIX 2020/11/17 02:27:16 GPST -
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